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This Quick Start Guide to the TRIUMPH-LS contains the
basic information a user new to J-Field, the field software of
TRIUMPH-LS and VICTOR-LS, needs to know to get started
working quickly. It is important that new users to J-Field
read and understand the information in this manual before
attempting to use J-Field. To obtain good results and RTK
solutions, it is most critical to understand the RTK
Verification and Validation process and settings. More
information and details are provided in the User’s Guide to
the TRIUMPH-LS. J-Field also contains its own ever-
growing on-board manual with context sensitive help files

EB
for various screens. Press the hardware Help
button to learn more about each screen.

v FIELD

J-Fieldisrapidly being developed with new updates typically
being released monthly; because of this, screenshots and
features in this guide may appear differently from the latest
version of J-Field. Be sure to check

and the user forum at frequently to
stay current on all of the breaking news and innovative
developments from JAVAD GNSS. Details about new
features can also be found in the Application Notes accessed
from the Support menu.

(Help)

Central to J-Field are four key concepts, briefly introduced
here and that are discussed more fully in their respective
sections:

Project - A user-defined job identifier with its own database file and folders
for storing data

Page - Each Project has 10 pages that can contain points and lines and can be
toggled on or off similar to CAD layers. Each Page has the option of having its
own coordinate system.

ShapeTags - User-defined tags for points that can be assigned to create lines
between points with like ShapeTags

Codes - Each point has a (ode field to store commonly used point descriptions.
Once a Code has been created, it can be recalled from the Codes Library or from
the Favorite Codes list.



Anatomy - Exterior of TRIUMPH-LS

Warnings - Press when
the warning LED is red to
view warning messages

Help - leam more  Lock - lock the

about the current  screen to pre-
screen vent accidental
actions

Start - Start the collection
of a point

Navigation
buttons

External GNSS

Top, Left and Front Faces

Screen - Cycle the screen to
Interference - Spectrum  white or black backgrounds for
analyzerto checkfor  better visibility in the sun
interference in the
GNSS bands

Print Screen - Capture
ascreenshot

ANV - Control Battery - status

sounds of the battery
volume andinternal
and display temperatures

Stop - Stop the
collection of a
point

Check - Used to open or
select the current item/box

antenna port Battery status
LED
Home - Press to return to
Warning LED / Battery LED the Home screen
(when off and charging)
Charge Status
External UHF LED
antenna port
Zoom In / Advance
to the next page/
Action - Open the Stake Action screen screen
/ Expand White Box buttons
Zoom Out / Advance to the High resolution
previous page/screen capacitance
color touch
RS232 port Speaker screen
LAN port
' 4 User Defined Buttons-
Slant height Customizable to invoke desired actions
mgaiurement Speaker / functions
poin
Collect- Cydle 0n/0flf— Turn on Mute-Mute  Light  Proximity
Charging port through the collect itfh:hgns';;the%digown the sound sensor. - sensor
Setup - Cycle between saeens unresponsive Liaht-T Joffth
the Setup and Advanced Stake - Cycle through N ﬂlgshli i:]tm on/off the
Setup screens the stake screens Builtin 9
Microphone
4 www.javad.com



Anatomy - Exterior of TRIUMPH-LS
Bottom, Right and Back Faces

Optional shoulder

strap connection Internal Radio

plug Antenna

Factory port
covers

Micro USB Port - This is for
connecting the Triumph-Is
to a computer. Use the
provided cable.

USB Port - Use this port for connect-
ing USB storage drives and dongles
to the TRIUMPH-LS. This is not for
connecting the TRIUMPH-LS to the
computer.

Headset

Slant height
measurement
point

Bottom

174" Flashlight Front
¢
amera x20 Camera
threads

www.javad.com

Micro SD card slot

Internal GSM
Antenna

WiFi / Bluetooth
Antenna

SIM CARD Slot 1

SIM CARD Slot 2

Serial number of
the TRIUMPH-LS



UHF antenna 400-470 MHz,
2.5dB, RT Angle, SMA (optional,
if UHF module is installed)

TRIUMPH-LS

AC Power Cable

Ext Power/Charger

AC Power Adapter

Power Cable

\3\\\.\@\

Charging kit
Shown assembled while the TRIUMPH-LS is being

¥
Q!



Screen Anatomy - Home Screen 1

GNSS Interference, the numeric
value is the maximum magnitude

| Battery - The estimated hours : minutes of remain-

of interference among all the GNSS ing battery life is shown below

bands

Satellites, number of tracked seettlljlg 35:2{2 ;?r'nteh ?s

satellites are shown above the icon displayed below . . .
and the Receiver Name is shown Coordinate Systems - lists all the system coordi-
below

nate systems, not used to set the current coordi-
nate system

(lickanyiconinthetoprowto ~ LAN ~ WiFi  UHF GSM BT

open its status screen Volume

Inactive connections are gray

Localize - Create localized coordinate systems
and active connections are blue

(ollect - Survey points Points -List the project points and polylines

Stake - Stake points and

i Files - Browse the file system, import and export
ines

files

Setup - Configure the ShapeTags & Codes - Manage Shapelags, Codes

setup profiles

Support - menu, used to
request support and install

(0Go - Various CoGo Functions, updates.

DPOS and Camera Tools

Setup Tags & Codes ~ Support

Updates available

Monday, December 21, 2015 05:21:59 PM

Messages Available
RAMS Connection

Established



Screen Anatomy - Home Screen 2

System - Receiver details and Language - Specify the Timing - Configure clock  Base/Rover Setup - Start a
information, etc. language display format, set alarms, RTK base station with a UHF
schedule data collection or SS radio

(amera - Capture photos with the

(alendar - Manage survey
front and bottom cameras

projects by date

oDa

Language

Interference - Complete GNSS Voice Recorder - Record audio

spectrum analyze @) notes

Camera Calendar Voice Rec.
£ + /]
Calibrate - Calibration for the level { ag n .
and compass i Locks - Prevent inadvertent
Calibrate Data Ex¢hange  Calculator Locks screen interactions
Monday, December 21, 2015  07:25:25 PM

Previous Screen - Advance to the Data Exchange - Export / Import  Calculator - Several  Taptoopenthe Next Screen - Advance to the
Home Screen 1 various data formats different calculators  Timing screen Home Screen 1

are available



Charging the Batteries

The TRIUMPH-LS AND VICTOR-LS come from the factory
with the batteries charged and ready to use so you can
begin exploring its interface and familiarizing yourself right
away while reading this manual.

-

Some of the cables and their
connectors used in charging
the equipment may not be
familiar to you. ODU style
connectors are superior for a
broad range of industrial

= Lithium lon batteries should not
|§-| and cannot be charged when
their temperature is above 40° C (104° F).
They charge faster when they are cool.
Therefore, it's best that you turn off the
unit when charging. Charging the unit
when it's on will cause it to charge more

slowly (up to 40° () due toits increased | POWer, communications
temperature. and  data applications
that demand a precision-
engineered, secure and

robust solution.

When charging your receiver, be sure to line up the red
dots on the connector and the charing port on the LS. Note
www.javad.com

that the four LEDs have different
' meanings when the LS is on from
' their meanings when the unit is
being charged. When the unit is
on, you'll want to pay attention to
the upper left LED as it alerts you of
P an immediate issue.

Warnings

|\ Anytime the TRIUMPH-LS displays
this LED as red, press the warnings
key to learn more and take any
necessary corrective measures.

Help & Support

J-Field contains its own ever-growing on-board manual
with context sensitive help files for various screens. Press
the hardware Help button to learn more about each screen.
Contact information of the Live Technical Support team
members are listed in Support>Live Technical Support. You
are also encouraged to submit your feedback and questions

to the user’s forum located at http://support.javad.com.
Turning on The TRIUMPH-LS

Powering the TRIUMPH-LS on is pretty straightforward
with the underlying operating system; Windows Embedded

On/Off Compact 7.0, loading first and then J-Field
subsequently booting up.

There are occasions when the system
might freeze. Should you experience this,
simply depress the power key and hold
down until the unit powers off, about 10

o,

seconds. Any data collected up to that point will be saved.



Calibration

The TRIUMPH-LS is an
advanced scientific surveying
instrument. It is highly
sensitive to its environment
and includes a built-in

Calibrate

magnetometer and 3-axis accelerometer.

For the visual stakeout features and the Ahead/Back
and Right/Left White Boxes in the Stake Action screen to
work correctly, the electronic compass readings need to
be accurate. It is recommended to check the compass
calibration before beginning work at a new location. To
check the calibration, rotate the TRIUMPH-LS 360° and
observe the compass readings in the Collect or Stake
Action screen. There should be no twitching, quick jumps,
or reversals of the displayed bearing or azimuth, just as a
real compass would perform. If this is not the case, the
compass needs to be recalibrated or it may not be in a
suitable environment for its use. Follow the instructions on
the screen to calibrate the compass. When calibrating the
compass, choose an area removed from overhead power
lines, parked automobiles and other ferrous materials which
cause magnetic disturbance. The electronic compass works
in areas that are electromagnetically uniform.

The Level calibration typically only needs to be preformed
once. Follow the instructions on the screen to calibrate the
level.

The level sensors are sensitive to the internal temperatures
of the TRIUMPH-LS. To fine tune the level calibration, a
Level Offset calibration needs to be preformed. It is located
in the Action Setup menu. It is necessary to reperform this
calibration as the internal temperature of the TRIUMPH-LS
changes. If the Correct For Tilts option is enabled and the
10

most accurate positions are desired, it is essential to monitor
the Level Offset calibration and recalibrate when necessary.

The Camera needs to be calibrated if you intend to use the
camera’s Visual Angle or Camera Offset Survey tools. This
only needs to be done once.

Updates

Keeping your TRIUMPH-LS
up to date is nearly effortless;
however, you do need to
ensure that you have Internet
access in order to download the firmware and software
updates.

The TRIUMPH-LS will automatically detect nearby WiFi
networks. To see the detected networks, as well as their
respective signal strength, tap on the WiFi icon in the top
row of icons on the Home screen and then at the bottom of
that screen tap on Network. Select the desired access point,
tap on Connect, enter the case sensitive password, if any,
and the connection should be established. Once
connected to a WiFi network it will be remembered
and added to the Favorites and the connection to it
will become automatic when it is detected.

—

If you do not have WiFi or for some reason are unable to
connect to it, but do have a wired local area network, you
can connect the TRIUMPH-LS to your network using a cable
connected to the LAN port and your network interface card
orrouter. A wireless network can also be used if you have an
installed SIM card data plan with sufficient data.

Once connected to the Internet, J-Field will automaticaly
check for updates. The Support button will be displayed



with the update symbol (cloud and
down arrow) and a sound will be played
periodically when a new update is
available.

Points

Tap on this icon to review
points, alignments, trajectories
in J-Field.

+  Base Station Coordinates - When a point is surveyed
with RTK corrections, the base station coordinate is
saved.

»  Survey Shifted Coordinates - When a point’s base
station coordinates have been adjusted or shifted, the
shifted survey coordinates are displayed along with
the unadjusted survey coordinates (Survey Origin).

«  Base Station Shifted Coordinates - When a point’s base
station coordinates have been adjusted or shifted, the
shifted base station coordinates are displayed along
with the unadjusted base station coordinates (Base

Station Origin).
[Survey O | Design @ | Polyline () | Trajectory OJ[DPOS]
Name 10 Design
— Code DefCode || North 723966 5181ft
Y Y (% =™ ! Description Stone || East 1784466 4532ft
T B 1 E Height 0.0000ft
Epoch 2010.0000
Name 1 Page Page1
> St Date (Local) 0511112016 03:06:08 cs NAgggt(ﬁ‘m)\(,ghég Survey Shifted Survey Origin
one Code DefCode North 723966 5781ft | North 723960 31811t
5 Stone Description Stone East 1784466.4132ft | East 1784467.3631ft
Page Page2 North 723966.5781ft || Height 1104.2217ft | Height 1087 8176ft
6 Stone o NAD3(2011) I Ohio South | East 17adaes dtsan Epoch 20100000 | Epoch 2010.0000
elgl . B - - -
9 Stone 475‘?::“?’;5: Epoch 2010.0000 Base Station Shifted Base Station Origin
10 Stone North g North 723898.4507ft | North 723892 19071t
ast 1778475 11391t Images 0
g East 1784477.8692f | East 1784478 81921t
11 Stake Up 0.0000ft Audio 0 > S
Height 984.6857ft | Height 968.2815ft
Epoch 2010.0000 Raw GNSS 0 |lEpoch 2010.0000 | Epoch 2010.0000
12 Stake Coords SRV:no DSN:yes BS:no - -
13 Stone/IP 1 0 it i Diffs Distance | AN | AE | AU
\ /\mages Additional Information DSN-SRV | 0072f | 0060R | D0d0ft | 1104k |
- T SRVs | 633t | 626t | O095R | -164Rt
Esc B@@@ Map

Points Screen Displaying Design Points

Each point record can have up to five types of coordinates
that are displayed in the Edit Points screen:

«  Design Coordinates - Imported and manually entered
coordinates are populated into this field and stored in
the Project’s database file with their native coordinate
system as was selected when they were imported.

«  Survey Coordinates - These are coordinates determined
from GNSS observation. All surveyed points are stored
with Survey Coordinates with WGS84 (ITRF 2008)
coordinates.

Points

+|

Cancel

Edit Point Screen Displaying a Point with Each Type of
Coordinate

CGREN &

In addition to these coordinate types, all post-processed
DPOS and Real-Time Shifted coordinates are also stored in
the database. These will be discussed more in the DPOS
section of this manual.

11



Screen Anatomy - Points Screen

Object Type - The radio button selects which type of
object is displayed in the list: Survey Points, Design
Points, Polylines (and lines) or Trajectories.

DPOS - The DPOS button opens the DPOS screen that allows raw GNSS data to be
submitted to the JAVAD Data Processing Service. Base station data can be processed
with CORS data to obtain real geodetic positions and rover data can be processed
with both the base station data and CORS data.

Add - The add button allows new points to be added; Processed Point Info - This button opens the Processed Point

with the Survey option selected you will b taken to Photo, Screenshots, Audio & Notes - These buttons Info screen. Here post-processed coordinates from DPOS can
the Stake Action screen. are active when a point has photos, screenshots, be compared to RTK coordinates and the desired coordinate
audio or notes associated with it. Tapping these can be selected for every point.

buttons will preview the associated file.

Edit - The edit button opens the Edit
Points screen (shown on the previous

page) to allow the various parameters of ) )
the point to be modified. Survey (O | Design @ | Polyline QO | TrajectoryO) |DPOS
[+ x)ly v o) (SIS (=TT
e v
1 Name osr120160a0e el Additional Actions - Viarious additional actions
Delete - The delete button deletes the 2 Stane Code Detcoce||  are available from this menu (see following
selected object. A Long Click (tap and 5 Stone (I :::: the pages).
hold) on this button deletes all objects 6 Stone ce NADB32011) Ohio South|
currently shown in the list, i.e. taking 9 Stone 475599 ssgoﬂ
into account the general filter and name 10 Stone E'a’s'{" 1778475.1139f
filter. 11 Stake gp . 2011) ggggg
12 Stake Chords SRV:no DSN:yes BS:no ‘
(13’ Stone/IP JImaaes 0
Esc - Escape to the previous screen " Esc E][Z]@ 4 X Map
Filter - Filter button (see next page) Point Information Panel - Information about
the selected point is displayed here. Alterna-
tive templates for this panel are available by
Type Filter - Type Filter button (see choosing Additional Actions>Settings>Info.
the following pages) The Default template is currently shown.
Name ier- Name Fiter buttin gapping this panel opens the Base-Rover
lame Filter - Name Filter button (see tatistics screen.
the following pages)
Map- Opens the map with the current]
List - Point Codes and Descriptions can be displayed beside the Point Name. Format- Se,fcteff point highl?ghted in the map /
ing options are found in Additional Actions>Settings>Columns>Name. Options also
exist here to display icons when the point is “Shifted” and when it has “JPS” GNSS data.
The “Type Filters” column option will display Solution Type, Process Type and Base Type ) _ .
abbreviations beside the point names. Page Numbers - Chages which page of the list to view

12 Points



Point Filters

Points are displayed in the coordinate system of the Current
Page in the CoGo functions and in the map. All new
Survey Points and points created with the CoGo functions
are created in the Current Page. The Current Page can be

selected by tapping (Filter Button) to open the Filter
screen. The First row displays buttons for each of the 10
pages. The Current Page is highlighted green while visible
pages are shown with bold numbers and hidden pages
are shown with small gray numbers. Tap a page button to
toggle it between visible and hidden. Objects in hidden
pages are not display in the list of objects or on the map.

[pages‘ ‘1‘2‘3‘4‘5‘6‘7‘8‘9

[In Current Project

)
@j[ln All Projects O]
[Distance Filter ]

100.0 ft ‘ DJ[ Additional Filters
¥ from Current Position

code, description, date
Sort by Distance (O WABLELTEE @

‘ Hide Bases

Chronological (O

[Hide Staked DJ

Reset filters OK §

Filter Screen - Current Page is 1, Page 0 is hidden

O ‘ Hide Vertices

The Pages screen can be open by tapping Pages. It displays
the page names and allows it to be edited along with the
coordinate system and color.

Points

Pages
Page0 Ol edit | O {PageS Q| Edit J
Edit {Pageﬁ Q| Edit j
Page2 O | Edit [Page? O | Edit J
[pages O Edit } {Pages O Edit j
[Page4 QO | Edit J [PageQ QO | Edit J

Page1: NAD83(2011) / Ohio South | NAVD 88

o

Pages Screen - Current Page is 1, Page 0 is hidden

Py
+!

The Current Page is set with the toggle on the left while the
visibility of Pages are controlled with the check box options
on the right.

The In All Projects toggle will display points from all projects.
This is usually not recommended as it will slow J-Field down
if many points exist.

Points can be sorted in the displayed points list by Distance,
Alphabetical or Chronological. Notice the down arrow in
the corner of the Distance Filter button. Holding this button
down will initiate a Long Click and present additional
options for the Distance Filter.

13



112 13 14/516 7189

Pages
Origin of Distance Filter

In Cul O
[ Current Position ]

Dista
[ From List ]

Sort @)
{ From Clipboard J

Hide JJ

Reset filters oK d

Origin of Distance Filter Options

Hide Staked hides points that have already been staked. A
point is considered staked after it has been staked with a
surveyed coordinate accepted for it.

Hide Vertices hides points created from imported lines from
being displayed in the point’s list. J-Field defines lines as
connections between points so every line must have points
at its vertices. For this setting to be applied the Hide Line
Vertices option must be checked in the Common Settings
screen when AutoCAD, DGN or Shapefiles are imported.

The (Type Filter) opens the Type Filters screen. It

allows points to be filter by Solution Type, Processing Type
and Base Type.

14

Type Filters

Solution Type Process Type Base Type
Standalone ¥ Real Time Auto
4 i (
() M - el
Known
DGPS Post Processed (KN)
(0e) &7 CORS Processed
(CP)
Float CORS Proc d
v
(FL) (CP) RTN
(RN)
Fixed Marked Process
m-Local
(FX) (MP) (ML)
[ Checkall | Uncheckall | ok *
Type Filters Screen

The (Name Filter) button enables/disables the name

filter. When it is on, four additional fields are shown to the
right: one text field and three switches captioned

, and @ Enter the search text in the text field
and specify which switches are active (activated switches
have a light blue background while deactivated switches

are white):

@ looks for names which begin from the search
string;

@ looks for names which contain the search string
in the middle, but do not begin or end with it;

@ looks for names which end with the search string.

Activating more than one switch combines the results:

Points



activate @ and @ searches for names which either

begin with the search string or contain it in the middle.

To search for a range of numbers use the format of
numberl..number2. This format matches names which
contain numbers in range between number1 and number2
(in the position defined by switches). E.g. if you enter
3..9 (assuming all switches are on), it will match names 3,
Stake04a, Pt9, but not names 174 or Point19a.

The E (Additional Actions) icon contains a list various
options, settings and functions related to the Points screen.
More information about the items contained in this menu
can be found in each of the actions’ Help screen. Of
particular interest are Settings and Cluster Average.

Settings has options to allow the Point Name, Code and
Description to all be displayed in the left panel of the Point
screen rather than just displaying the Point Name.

Cluster Average finds groups of points in a cluster and
creates an averaged point from the group.

Adjusting a Base Station Position

Additional actions

£ Settings 3 Import r Export

™ Media & Update list

Cluster

LD Add to
Clipboard
w Average

I ){

I ){
Multi-select J{ i Yortical J[ / Batch Edit

| ){

Report

Screenshots L statistics

[
[
(
[

|
|
%
‘R N

Additional Actions screen
The information panel (the right blue panel) may contain

more text than fits in its view. If this is the case, tap and drag
the panel to scroll its contents.

15



Coordinate
Systems

3 The  Coordinate  Systems
screen allows you to quickly
access and create new
coordinate systems based on
the predefined systems with just a tap on this icon.

Coord. Sys

It is important to note that this screen does not set the
current coordinate system for the Project. To change a
Project’s coordinate system choose Project>Edit Current
Project>Project Coordinate System in the Stake and Collect
Prepare screens. Each page in the Project can then also
have separate coordinate systems, set from the Page and
Coordinate System boxes in these screens.

{Current Project @ ‘ All Projects QO | Default OJ
Hlslxlvia) =
$E NAD83(2011) / Ohio South | NAVD 88 ErEE

Name NAD83(2011) I Ohio South |
NAVD 88

Epoch 2010.0000

Geodetic Datum
Semi-major axis
Inverse flattening 11298.257222101
Prime meridian 00°00'00"
HTDP WGS84(ITRF2008) to
NADA83(2011) / NAVD 88 / SPCS83
Ohio South zone

6378137.000m

Coordinate System Screen

Adding a State Plane Coordinate System

To add a new coordinate system that is currently not listed
in the Coordinate System screen when the All Project button

16

+
is selected at the top of the screen, tap the (Add)

button to open the Coordinate System Catalog.

Coordinate System Catalog

CRE— - - 3

Global

Regional

C ) (@ Yo | wopo |
[rﬁ WGS 72 ][Fﬂ WGS 7ZBEJ [Fﬂ Oceania J
(2

WGS 84 ][rﬁ PZ-90

Unknown J{K@' RTCM 3.x J

Back
Coordinate System Catalog Screen
When selecting a Regional system for your project from the
vast catalog, filter the choices to just those relative to your

geographic location by checking the Near Me box. Select
your Region, Country and type of coordinate system:

United States (USA)

J [@8) SPCS(NADS3 2011)

® NAD27

&8 SPCS(NAD2T)

@8 UTM(NAD27)

& NADs3 @ NADS3(2011)

@ NADS3(HARN)

N\ N
A, N,

[@ NAD83(NSRS2007)

N, .

Coordinate Systems



SPCS(NADS83 2011)

[-E- NAD83(2011) / Ohio North J NAD83(2011) / Ohio South

Select the appropriate Height System, Geoid, Input Epoch
and Transformation.  The typical coordinate system
configurations for a US State Place Coordinate System is
shown:

NAD83(2011) / Ohio South | NAVD 88

Name: NAD83(2011) I Ohio South Related geodetic system: NAD83(2011)
Projection: SPCS83 Ohio South zone (0; )
Area: 38°24'00"N...40°21'00"N x 084°48'36"W...080°41'24"W

{ $ Height System: NAVD 88 >]

[g Geoid: GEOID12B CONUS South 42N >

@& Input Epoch: 2010.0

Transformation: HTDP WG S84(ITRF2008) to NAD83(2011) / >
NAVD 88/ SPCS83 Ohio South zone

4 Adjust Grid-to-Ground & Rename >

For latitudes south of 42N, “Geoid12B CONUS South 42N”

should be chosen and for latitudes north of 40N, “Geoid12B
CONUS North 40N” should be chosen.

Coordinate Systems

It is important to remember that GNSS distances measured
in State Place Coordinate Systems may not match measured
ground distances exactly and typically need to be scaled to
ground. For this reason you may wish to create an adjusted
grid-to-ground coordinate system. Alternatively, the CoGo
functions in J-Field have the ability to display and input
ground distances while still working in an unmodified State
Place Coordinate Systems (see the CoGo chapter of this
manual for more information).

Creating an Adjusted Grid-To-Ground
Coordinate System

With your state plane coordinate system selected in the
Coordinate System screen click the Additional Actions

—
1
-

button | and tap Duplicate to create a copy of this
coordinate system. The duplicated system will be created
with the date appended to the end of its name:

Current Project All Projects Default
Additional actions

NAQ [ Duplicate J
South |
AVD 88
10.0000

[1 Import ]
7.000m
222101
[F’ Export ] 0000

17



{Current Project O ‘ All Projects

xv]a)

NAD83(2011) / Ohio South | NAVD 88 )
NADB3(2011) / Ohio South | NAVD 88... [l c

Default name

O | Default OJ

Grid System

NAD83(2011) I Ohio South |

NAVD 88 2015-12-03 15.62.31

NAD83(2011) I Ohio South |
NAVD

Epoch 2010.0000

Geodetic Datum |
Semi-major axis
Inverse flattening

6378137.000m
11298.257222101
Prime meridian  00°00'00"
HTDP WGS84(ITRF2008) to
NADB83(2011) / NAVD 88 / SPCS83

Now highlight the duplicated system and tap the edit
icon and choose Adjust Grid-to-Ground & Rename:

NAD83(2011) / Ohio South | NAVD 88 2015-12-03 15.52.31

@ Adjust Grid-to-Ground & Rename >
- e

Grid System
Name NAD83(2011) / Ohio South | NAVD 88 2015-12-03 15.
52.31
Default name NAD83(2011) / Ohio South | NAVD 88

Epoch 2010.0000
|

Geodetic Datum

Semi-major axis 6378137.000m

Inverse flattening 1/298.257222101

Prime meridian 00°00°00"
HTDP WGS84(ITRF2008) to NAD83(2011) / NAVD 88 / SPCS83 Ohio South

Znna

" Esc

18

Adjust Grid-to-Ground & Rename

[Name NAD83(2011) / Ohio South | NAVD 88 2015-12-03 16.40.55 | py) Dg‘u}
[Nonh Origin 0.0f | East Origin 0.01 ‘ [ :\J
North Ground 0.0ft | East Ground 0.0 :‘

Rotation [N Scale Difference
North Inclination 0.0" | EastInclination 00" J
Vertical Offset 0.0t

Adjust Grid-to-Ground & Rename Screen

o

Tap the Default button OFLT 4o change the coordinate
system name to the default name:

Adjust Grid-to-Ground & Rename

[Name NAD83(2011) / Ohio South | NAVD 88 PI;‘UJ
[Nonh Origin 0.0ft | East Origin 0.0t m
North Ground 0.0ft | East Ground 0.0ft | [ J
Rotation 0°0'0.0" | Scale Difference 0.0 ppm
North Inclination 0.0" | East Inclination 00" J
Vertical Offset 0.0 ft

Tap the position icon beside East Origin to set origin
point in the grid system for the transformation. Here the
base station coordinate is chosen from the points List:

Coordinate Systems



Get from BaseProject1, Hub, <none> Saveto
Survey North, East, Height Design
Manual 7238895487ft Clipboard
1784473.7876ft
Map 955.1242ft
Clipboard i
NAD83(2011) / OShSIO South | NAVD

Cancel

By default the ground origin point will be populated with
the same coordinate and the Scale Difference is populated
with the grid-to-ground scale factor calculated from that
point. The scale factor rounded to the nearest part-per-
million (ppm) is automatically appended to the coordinate
system name:

Adjust Grid-to-Ground & Rename

NADB83(2011) / Ohio South | NAVD 88 GRD: 50ppm

P
OFLT

5
PROJ

ame
[

North Origin 723889.5487 ft | East Origin 1784473.7876 ft
North Ground 723889.5487 ft | East Ground 1784473.7876 ft
Rotation 0°0'0.0" | Scale Difference 49.504 ppm
North Inclination 0.0" | East Inclination 00" J
Vertical Offset 0.0t

You may also wish to round the scale difference to the
nearest ppm by tapping its button and entering that value.
In this screen options exist to enter a new factor as a Ratio

Coordinate Systems

or Ppm:

ppm ‘

‘Scale Difference: +50.0

The Factors button will allow you to use the CoGo Scale
Factor function to calculate a new scale factor if desired.

These settings will create an adjusted state plane coordinate
system scaled around the base station and the base station
coordinate will not change. This is useful for projects that
have ground distances as would be measured with a total
station and state plane coordinate system bearings since
the rotation is set to 0. The coordinates will be very close
to the real state plane system so that orthographic imagery
and state plane referenced contours or elevation models
can be loaded into your CAD drawings. You should be
cautious when giving these coordinates to others as they
may confuse them for real state plane coordinates. To
solve this problem you may wish to subtract 100,000 from
the North and East Ground coordinate values to create a
(100,000 100,000) offset from the real state plane system.
This can be done by tapping the North Ground and East
Ground boxes.

Tap the PROJ putton to add the current project’s name to
19



the beginning of the coordinate system name:

Adjust Grid-to-Ground & Rename

{Name Project! - NAD83(2011) / Ohio South | NAVD 88 GRD: 50ppm @

{Nonh Origin 723889.5487 ft | East Origin 17844737876 t | [ \J
North Ground ~ 723889.5487 ft | East Ground 17844737876 1t | [ \J
Rotation 0°0'0.0" | Scale Difference 50.0 ppm
North Inclination 0.0" | East Inclination 00" J
Vertical Offset 0.0 ft

Press OK and then Apply to create this coordinate system:

[Current Project @ ‘ All Projects O ‘ Default OJ

Bu0 =)
Grid System

NAD83(2011) / Ohio South | NAVD 88
=mz Project1 - NAD83(2011) / Ohio South ... [IEILES Project1 - NAD83(2011) | Ohio
South | NAVD 88 GRD: 50ppm

amn
Default name NAD83(2011) I Ohio South |

Epoch 2010.0000
Geodetic Datum
Semi-major axis 6378137.000m
Inverse flattening 11298.267222101
Prime meridian °00'00"
HTDP WGS84(ITRF2008) to
NAD83(2011) / NAVD 88 / SPCS83

You can now use this coordinate system as the Project
Coordinate System or just for some Pages if you choose.
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Files and Data Exchange

Data transfers between the TRIUMPH-LS and your PC are
facilitated through using either a USB cabled connection,
a USB flash drive, a cloud drive or a network drive. Using
a cloud drive or USB flash drive are the simplest and
recommended methods to transfer data between your PC
and J-Field.

Data Base Structure and Customize
Screen

Each J-Field Project has a “data.db” file stored in its project
folder found in “Internal Memory\ VS Data\Maps”. All the
points and lines for a project are stored in this file. By default,
the Internal Memory is hidden. To allow it to be visible in
J-Field you can enable this option from System>Customize.

The Long Click Time setting in the Customize screen con-
trols how long a button must be held down to register as
a Long Click. Some button in J-Field preform two actions
with the second action being initiated with a Long Click.
Buttons with these second actions typically display a small
down arrow in their bottom left corner.

Check the Double Vial Detector option if you are using the
Javad rover rod with a double leveling vial. This allows the
downward facing camera to detect both vials.

Files and Data Exchange

Customize
Long Click Time
{Shon @ ‘ Medium O | Long OJ
{Double Vial Detector J
Allow Browsing Files in Internal Memory 2

Customize Screen

Working with WMDC

Using the provided micro USB Cable will allow you to browse
the contents of the TRIUMPH-LS using Windows Mobile
Device Center (WMDC); take care not to delete system files!

The first time that you connect the two devices, Windows
will install Windows Mobile Device Center, a pretty
straightforward process largely tailored to other types of
mobile devices.

:_‘5 Set up your device
Click on‘Connect
without setting up
ili comectutautsetingupyourceice I your device’
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.

Click on ‘File Management,

and then ‘Browse the
contents of your device’
ey u Wobile Dvie Setings
- This is how the
b e ¢ G e oG [  TRIUMPH-LS is seen by
File Edit View Tools Help .
Organize + - A @ Windows
s LIMA (L) o \
s MONA (M:) = [
. NARU ) S 756 MB free of 730 vee— | Windows operating

o= Network
o= Storege Card
. VS Data
I\ Cache
I\ Demo export
|| Eportsfrom LS
I\ Maps
| SDefault
I\ SMedia
1L SPictures
|| SRaw Data
L 001 RTK
1 1420 Smith
I\ 1422 Cunningham

Height Modernization
Incline thine car
) Map 2014-01-26 16,0010
. Motel
)\ P2014-06-10 08.54.21
. P2014-07-13 093031
. RTK from MDOT
| RTKfrom T2
| RTK from T2 5PCS
. RTK from UMO

RTK using SIM

I\ T2 base Testo2
11 V6 test o1
11 V6 test02

I\ Media

I\ Photos

J! SereenShots

| UpdateService
J. VS Date_backup

22

= -

system, J-Field, support

== files etc. are in the root
- 55 i G .
directory.
When  present, the

attached USB  dongle

device will show here too .
Good practice is to use

the provided microSD
card for survey-related

= Survey projects
data storage including

are  automatically

. assigned to their own || Media, Photos,
" folders at the time of the || Screenshots and
Project’s creation and are Spectrum data.

similarly named as the
project. All projects are in
sub-folders beneath the

~  |parent folder'Maps’

Files and Data Exchange

Mounting a Cloud Drive

J-Field supports Google Drive and Dropbox cloud drives.

Browse Files in: (System Root)

e (]« O] =

Internal Memory\

= SD Card\
\\mattjohnson00@gmail....
£%5 mattjohnson00@gmail....
L. \\Office\TriumphLS\

][Show j
All Files

Files>Browse Files screen showing mounted Google Drive,
Dropbox and a shared network folder.

To mount a cloud drive navigate to https://app.javad.com/
jca/#/inventory/devices and login from your PC’s browser.
If you have not setup a Javad.com login, you will need to
do so.

@ | httpsy/appjavad.comyjca/#/inventory/accounts @ Qsearch
Cloud accounts
Home / J-Field assintant
© J-Field assintant
Cloud accounts
Please login
Vou have to be logged into continue.

www.javad.com



After signing in you will be prompted to Grant access.

@ Authorize - JAVAD - Mozilla Firefox — [m] *

://appjavad.com/auth/OAuth/Authorize?response_type=code8iclient_id=(

Authorize
Hello, matt8200
JAVAD Customer Area application would like to:

« View your e-mail asociated to login at Javad.Com
« View your public profile at Javad.Com

« Manage your cloud storage accounis

» Manage your connected device list

Sign in as different user

© 2015 - Copyright JAVAD GNSS, INC @

Click Generate Key and a new alphanumeric key will
appear. In J-Field open System>Dropbox/Google Drive and
tap Handshake Key to enter this key. Then click Establish
Connection. Note that J-Field needs to have an Internet
connection established during this process.

Dropbox/Google Drive

Please visit our JAVAD Customer Area at app.javad.com and
navigate to J-Field Assistant/Devices section.

Follow to instructions in Connect device widget on the page to
generate a new handshake key.

Enter this Key into the Handshake Key field below and click
Establish Connection button to complete the procedure.

Handshake Key
— Establish Connection -
Esc OK

Once this is completed, return to your web browser
and select Cloud accounts in the left pane. Then click
Connect Google Drive or Connect Dropbox. You will be
prompted for your credentials for these accounts.

After these steps are completed open Files>Browse Files

and click the context menu icon and choose
Mount Cloud Drive. You should see your Google and
Dropbox accounts listed if you completed the previous
steps correctly. Choose the desired account and press
OK.

Files and Data Exhange 23



Mounting a Shared Network Folder

Mounting a shared network folder allows files to be
transfered to and from J-Field while it is connected to a local
network. First a folder from a PC connected to the same
local network as the TRIUMPH-LS needs to be created.

General | Sharing | Securty | Customize

Network File and Folder Sharing

TriumphLS
l Shared

Network Path:
WOFFICENTrumphLS

Advanced Sharing

Set custom pemissions, create muttiple shares, and set other
advanced sharing options.

'@' Advanced Sharing..

Password Protection

People must have a user account and password forthis
computerto access shared folders

To change this setting, use the Network and Sharing Center.

Close Cancel Apphy

Here the folder TriumphLS was created on the Desktop.
Right clicked on it, selected Properties and then enabled
Sharing in the Sharing tab.

Then in the Browse Files screen, choose Mount Network

Share from the File Operations menu when you are in the
System Root directory.

24

Files and Data Exhange

Internal Memory\ ‘ ‘ ‘ (] ‘ ‘
Intepmalis
SD File Operations
Ei\e)
{ﬂ' Mount Network Share J
|\ H All Files ‘

(o’

Then enter the network path as shown above along with
your Windows account name and password.

Mount Network Share
Server Address
WOFFICE\TriumphLS
Login
Matt
Password

123

Press OK and you should now see this folder shared in the
Root Directory where it can be used to import and export
files.

www.javad.com



Browse Files in: (System Root)

[ \\OFFICE\TriumphL S\

[+ B0 =)

Internal Memory\

SD Card\

Filter Show
All Files

Note that if an error message is received while trying to read
the network shared folder, it may be necessary to reboot
the TRIUMPH-LS to resolve this. This is a known issue with
the Windows operating system in the TRIUMPH-LS.

Importing Points From a Text File

To import points from a text file open the Data Exchange
screen from the Home Screen 2 or from Files>Data Exchange.

Data Exchange

Files

Import > [l" Export >J
Bluetooth

{Generic Bluetooth Data Exchange >J

[Leica GSl Bluetooth Export >j

Data Exchange Screen

Files and Data Exhange

Navigate to the location where your file is located using

the to go up a directory and Open to open a folder.
Then select and highlight the text file to open and choose
Open. (Notice the down arrow in the corner of the Navigate
Up button. Holding this button down will initiate a Long
Click and navigate to the system Root directory.)

Open File in: mattjohnson00@gmail.com\

ol + o B0 =

[ Project1ImportPoints.txt

i Camera Uploads\
[53 Development\
Ik Project!ImportPoints.txt

[Finer j[smw J
(Empty) Text Files

Open File Screen - Filtered to show only text files

If your text file is configured with the standard format of
“PointName, N, E, H, Description” you should configure the
import settings as shown below if they are not presently
configured this way. The preview should display if the
format is being interpreted correctly.
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Presets

Import file: Project1importPoints.txt

Field Skip Lines
Sep. Space @ |8 Other () - 0
Choose) || Name Prefix | Name Suffix

a0 O O (Choose)

[ﬁ| Name ‘ N/Lat ‘ E/Long ‘ U/AIt Description :{)j

1 1 487816.24640 190185346907 897.26800 Pipe

2 2 487777.03647 1902044 48630 897.26800 Pipe

3 3 487762.35158  1902255.37564 897.26800 Pipe

4 4 487749.39629 1902585.12124 897.26800 RR SpikeOak...

5 5 487737.78938  1902660.53324 897.26800 Pipe

6 6 487578.59067 1902837.65239 897.26800 Pipe

Back

If the preview is correct, press Next.

Import file: Project1importPoints.txt

Points in file: 10
Coordinates range: N:( 485995.38ft - 487816.25ft)
E: ( 1901712.92ft - 1903697.44ft)
H: ( 655.31ft - 897.27ft)
o i (s [ Pagef J[With Default Code ]
Import into Page: age DefCode

Coordinate System: NAD83(2011) / Ohio South | NAVD 88

Point names are OK.

¥
Import

A summary screen will be displayed. The points will be
imported into the selected Page and be imported to
the coordinate system of that Page. Tap Import to finish
importing the points.
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Exporting Points To a Text File

To export points to a text file open the Data Exchange
screen and choose the Export option. Choose the format
of the file type you wish to export with the box in the lower
right corner, in this case Text/CSV. Navigate to folder you
wish to save the file. Click Save File in This Folder or the
New button to proceed. If you desire to change the default
filename of the file to be created, you may do so by clicking
on the filename box displayed to the right of Save File in
This Folder.

Save File in: USB Device\

[ L.t @
\d
Save File in This Folder Project1-160110.txt

[Filter j[Format
(Empty) Text/ICSV

Esc New

EED‘ 5]

-+ AN N

Save File Screen - Set to save a txt file in the USB drive

The Export Formatting screen will be displayed. It should
have the default configuration to export a“PointName, N, E,
H, Description”file with the description field being a merged
field J-Field’s Code, Attributes and Description fields. These
fields are merged together with the use of Sep. 2 (Separator
2) set to be a space. By default, fields are separated with
Sep. 1, typically set to be a comma. Highlighting a field from
the box on the left side of the screen and tapping Sep. 2 will
add a plus sign after the field name to indicate that it will be
separated with Sep. 2.

Files and Data Exhange



Output points: 8

Export to file: Project1-160110.txt

Export Range Project

[Coordinate System

Project1 - NAD83(2011) / Ohio South | NAVD 88 GRD: 50ppm

b D80C

N NN

N N/ At =
Name Attribute 2 +

N Attribute 3 + {Sep. 1 ‘ , }[Sep. 2 ‘ Spc

= Attribute 4 + : -

H Attribute 5 + [Dec'ma's 3 }[Heade" Line(]
Code Name + Description + _ . More

Attribute 1 + I ) [Deamals, 10 j[Setﬁngs >

Next §

Export Formatting Screen with Default Formatting Shown

The plus and minus buttons are used to add and remove
fields while the up and down arrows will change the
order of fields. Presets allows configurations to be saved
and recalled. Options are displayed to set the number of
Decimals exported and whether to export a Header Line.
More Settings opens the Export CSV Settings screen where
options exist to specify how to format cut and fill values and
Surveyed Design Points.

Export CSV Settings
{Format LatiLong DJ[Sfeﬁfm CutFill ‘ Cut ] Fill J

Append Unit Names to HeaderDJ[Quote Fields with Quotes O

Horizontal Length Units Vertical Length Units
Custom (U.S. Survey Feet) Custom (U.S. Survey Feet)

oy

Export Surveyed Design Points as Separate Points
Add 1000 to Design Point Names Numeric VValue

B

Do Not Write Code If It Is "DefCode" J

" Back

Export CSV Settings Screen

Files and Data Exhange

Use Export Range to choose which points to export.

What to Export
All Project Points C By Page O
By Page and Code DeiCode () List O
(points: 10)
Trajectory as Points O All Page Trajectories as O
(not selected) Points

Page
Page2
Design Points [ [Surveyed Points J{gg{:ﬁged Design Dj

Output points: 8

" Esc

What to Export Screen

After the settings and points to export have been selected,
tap Next to preview the formatting and points before
pressing Export to create the file.

Export File Preview

100,590058.680,1846652.741,717.964,IPF 1/4
101,590061.089,1846592.985,717.897 Pipe 1/2
102,589941.448,1846586.316,718.265,Pipe 1/2 Pinch
103,589938.850,1846646.255,717.952,Pipe Bent
104,590055.424,1846737.442,716.407 Pipe 3/4 Pinch
105,590051.676,1846822.644,715.361,IPF 7/8
106,589934.906,1846731.623,716.550,Pipe 3/4 Pinch
107,590044.731,1846992.639,714.718 Pipe 1/2

Export File Preview Screen
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Exporting Photos, Screenshots, GNSS
Data and Project Archives

To export media files that include photos, screenshots,
audio files and raw GNSS data files choose the Project
Archive File (ZIP) format option in the Save File screen. A
full Project Archive can also be exported with this option. A
Project Archive contains all the files necessary to restore the
project if it becomes corrupt or deleted. It can also be used
to copy the project to a different TRIUMPH-LS.

Save File in: USB Device\

-

L

-

il

O

i
I/

S

J\ J
(]
=)
&

A
Project1-160111.zip J

J Format
(Empty) Project Archive Fil...

Esc New

A\
{ Save File in This Folder ‘
{Filter

.
+)

Save File Screen - Set to save a Project Archive file in the USB
drive

After tapping Save File in This Folder or the New button you
will be presented with options to specify what type of files
to export in the Export Project Archive screen. Use the Full
option to create a backup that can be restored. The Only
Media option will export only the filetypes chosen. Press
Create to export the files which will all be contained in a zip
file.

Compress to file: Project1-160111.zip

[Fuu @) ‘ Only Media @J
[Comment J
Include

[Photos ‘ Audio (@) Raw Files (V2

Created archive will contain only media files. It cannot be used with
"Unpack archived project" command.

Export Project Archive Screen - Set to export only photos
(screenshots included) and raw GNSS files

Exporting A Project Report

A report of the Project can be exported in HTML or PDF
format by choosing HTML or PDF format in the Save File
screen. The report will contain the selected points with
all the details and statistics about that point. The Text &
Images will be included if this option is checked. A number
of options exist to format the PDF or HTML report:

Export to file: Project1-160111.pdf

Export Range Project

{Cccrd inate System

Output points: 8

~_/

Project! - NAD83(2011) / Ohio South | NAVD 88 GRD: 50ppm

Text & Images @ Images Only O

[Text Only O

S

[PDF Open Password

Letter Portrait

[Image Types

N J

J{Page Numbering Page 7 of 100

Back

+

Export

Files and Data Exhange



ShapeTags &
Codes

* Create and manage your
Tags & COdes own library of Codes; alpha-
numeric textual assignments

to points. Codes can quickly be recalled from the Favorite
Codes screen, eliminating the need to type in a point
description for each surveyed point. In addition, each Code
can have up to five Code Attributes fields. An example of
a Code is “IPF” (Iron Pin Found). It can then be setup with
Code Attribute fields of “Size”, “Cap” and “Status” which allow
these attributes to be entered and stored with each point.
Choose Tags & Codes>Manage Codes to access the library of

Codes.
Code: Corner Edit
Number: 1
Categf)ry.: ot Category to show Monument J
Description:
[DefCode Corner Hub } IPF {IPS }
Mag Nail g:ggi(;t;c Monument  |Nail Pipe }
Post [Spike Stake Set Stone J

|
|
| | |
) | )
) ) )

|
|
l l

—_———
S S

|
l

"~ Back

lf—f—

Manage Codes Screen

Tap Create or Edit to make a new Code or edit an existing
one. A Symbol, ID, Category and Code Description can be
assigned each Code. If a Symbol is associated with a Code,
points with that code will have the Symbol displayed on
the map. The ID field is a numerical field that is not used
in J-Field but is an export option for text files and may be

ShapeTags & Codes

useful with other software packages. The Category can be
used as a filter in the Manage Codes screen.

Edit Code

CO— - |
{lD 1 J{Category Monument J

{Code Description

Size <EMPTY>
Cap <EMPTY>
Status <EMPTY>
<EMPTY> <EMPTY>
<EMPTY> <EMPTY> )
Edit Code Screen

ShapeTags can be assigned to points during data collection
to enable the automated drawing of lines between points
with like ShapeTags. For example, you may want to create a
ShapeTag of “Fence”. When collecting a point along a fence,
select the “Fence” ShapeTag to be assigned with that point.
This will cause a line to be drawn on the map between
that point and the previous point that also has the “Fence”
ShapeTag.

ShapeTags are associated with a chosen Code when a new
ShapeTag is created. When a ShapeTag is then selected to be
assigned to a point, by default, the Code field for that point
will be populated with the associated Code.
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Setup

J-Field's settings are divided
into 3 profile groups: the
General Group, Action Group
and Favorite ShapeTags and
Codes. These groups exist
so that different settings
groups can quickly and
easily be saved and recalled.

¥

Setup

The General Group profile stores the settings for RTK
corrections, i.e. the configurations for UHF radios or
connection parameters to a RTN. The Advanced Settings are
also stored in the General Group and are found as an option
in the first setup screen of the General Group, they include
the settings for the displayed units. Tap Edit>Advanced to
access them.

Set Up|

The (Set Up) will quickly open the Setup screen;
pressing it twice opens the Advanced Settings Screen.

As an example, to configure a new RTN setup you would
tap Create to create a new General Group profile and then
follow the screen prompts to enter the communication
parameters and settings. See Appendix A: Creating a RTN
Profile for detailed instructions on setting up a RTN. Copy
As creates a copy of the existing profile but prompts you to
enter a new name for the new profile.
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General Group; current: UHF

. Recall /
Ve ) e e

Action Group; current: 1 Epochs, Standalone
. Recall /
[/ Edit J[ Mzﬁzge J[ * Create ][ Copy As J
Favorites Codes & ShapeTags; current: Boundary Survey

{/ Edit J{ ﬁzﬁaalgl,):; J[ * Create J{ Copy As J

(=1

Setup Screen

GNSS >

%, RTK/DGPS

<P Antenna

4 TCP Server

'1'1 Units

+¢ Real-time Position Shift

Base Reference Frame

VIV | V|V IV |V

=

Advanced Settings Screen

Tapping the Recall / Manage button will open a list of
profiles shown on the left side of the Profiles screen. Details
of that profile are displayed in the information panel (the
blue box on the right side of the screen). Across the top
from left to right are buttons to Rename, Delete, Search,
Sort Alphabetically, Sort by Date.

Setup



General Profiles

AB @

7

Factory Defaults Name
i 01/14i2016 18:15:42
ODOT VRS Last Time
Mode Rover
Ref. Frame NADB83(2011)
Channel UHF
Protocol JAVAD
Frequency 45180000
Rcv. Format RTCM 3.0
A\ /

oy
Recall

Cancel

General Group Profiles Screen

The Action Group profile contains the collection settings.
These include the RTK Verification and Validation settings
and how many epochs to collect. These settings are
discussed in the Collect section of this manual. The
configuration of the Stake and Collect Action screens’ User
Defined (whitebox) Buttons are stored in the Action Group
profile as well as the U1-U4 hardware button options.

Action Setup (Boundary)

‘ J Stop After 100 epochs @

with \/6 reset

Start with Start Button

Only RTK Fixed +j Verify

Correct for Tilts C]j 4 What To Record >

Revert Code to ShapeTag

Level Offset J default

5min}

Activate Post-Processing
option after

N - N N _N( ..
N~ N N
L A N

Recall

sc (0]

1
m
H
+|

Action Setup Screen

Setup

The Favorite ShapeTags & Codes profile stores different list
of favorite ShapesTags and Codes.

Setup Favorites (Boundary Survey)

Favorite Codes >

[Favorite ShapeTags >J

[Auto Sequence >J

Recall

Esc

Setup Favorite ShapeTags & Codes Screen
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Base/Rover Setup

Base/Rover Setup

Base/Rover Setup is used to configure and start the
transmission of RTK corrections via UHF or FH915 SS
(frequency hopping spread spectrum) radios from your
Javad Base receiver and radio to your Rover. It reads the
communication parameters from a UHF or SS General Group
rover profile and creates a matching base station profile
internally. It then sends that base station profile to the base
through the Bluetooth connection.

Before Base/Rover Setup can be used a UHF or FH915 SS
General Group rover profile is needed. If one does not exist
yet, open the Setup screen and tap Create for a new General
Group profile:
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General Group; current: Default Setup

T e o e

Action Group; current: 600 Epochs, Resets

Edit J{ Recall

[0 ]
| # create ]
)

Favorites ShapeTags & Codes; current: Boundary Survey

Edit J[ Recall * Create

Assign U1-U4

Setup Screen - Creating a new General Group profile

" Esc

Enter a profile name (“UHF” or “FH915 SS” are suggested) in
the next screen and tap OK. The next screen will prompt
you to select the Operating Mode, choose RTK Rover:

Operating Mode

RTK Rover

RTK Base O
‘ Stand-Alone O ‘
{ Advanced J

You could tap Next and continue to configure all the
communion parameters but this is not necessary as they
can also be configured with Base/Rover Setup. Press Back
and then Esc to return to the Home screen.

Base/Rover Setup



General Group; current: UHF

Once a UHF or FH915 SS General Group profile has been : +
created and recalled, tap the Base/Rover Setup button from

the second page of the Home screen.

Action Group; current: 600 Epochs, Resets

{ Edit

[orem  [Fooe )

Favorites ShapeTags & Codes; current: Boundary Survey

Edit

Recall J{ * Create J

If for some reason the selected profile is not in UHF or FH915
SS mode a message will be displayed indicating so. )
Should that be the case, tap Recall to select a UHF or FH915 T
SS radio profile or tap the displayed message to change the  |[VzI38
current General Group profile into a UHF or FH915 SS profile. |G

Assign U1-U4

~ Connect
b\

W7 iTe|all ¥
7 No Connection! 'y

@

ere to switch to "UHFﬁ

mode and set parameters
OR "Recall" a profile.

From Base

To connect the Base and the Rover via Bluetooth, tap
on Connect. The external radio, if using one, should be 3
powered on prior to pressing Connect. Always have an
antenna connected to the radio before powering it on to
avoid potential damage to the radio. UHF

To Base

Connect

- :F No Connection! ‘?

0
NAD83(2011)

RTCM

3.0 Min

0.2 Sec
451.80000 MHz
D16QAM, 12.5 KHz

On, On

From Base

Base/Rover Setup

To Base

Start Base
Triumph-LS 9DT_00151

Recall Copy As Done

Start Base
Triumph-LS 9DT_00151

Recall Copy As Done
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Immediately a scan of available Bluetooth devices will Connect Bluetooth Device

begin and a few seconds later will be completed. Choose 3
. . . JAVAD TRIUMPH2 00104 i i
the device intended to be used as the Base receiver and tap J[Cm"ec‘ J[sca""'"gj
Connect. (JAVAD TRIUMPH2 00104 N )
A\ VAN v
= +

Once the Bluetooth connection has been initiated, it will
take a few seconds before it has completed. During that

interim few seconds, your screen may appear like what is = Triumph-LS 9DT_00151
shown on the right. :

Start Base

=

| | S

NAD83(2011)
RTCM 3.0 Min

1 Sec

451.80000 MHz
D16QAM, 12.5 KHz
On, On

From Base|| To Base Recall Copy As Done

Once the existing Base and radio parameters have been

retrieved the screen should look similar to this. The Rover 3 Disconnect Start Base

profileradio parameter§are<Eiisp.Iayed ontheleft panelwhi!e = =3 Triumph-LS 9DT_00151

the current Base coordinate is displayed on the right. Radio  |IESENSICISCRIEH TR EISl JAVAD TRIUMPH2 00104
parameters displayed in red indicate that there is a different e @

value between the Base and Rover profile. Use From Base to 0 1| N 179850.2454m N—
update the Rover profile to the parameters from the Base or ez Rlettll A i too far
use To Base to send the Rover radio parameters to the Base NAD83(2011) / Ohio South | NAVD 88
before starting the Base. é,%g%%’?ggzmz

on On JAVTRIUMPH_2A NONE
20m+0025m Vertical

From Base|| To Base Recall Copy As Done
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Tapping the left panel opens the screen to configure the
radio parameters. “RTCM 3.0 Min” Format should be used to
minimize the correction data that must be sent through the
radio. To start the base with 5 HzBEAST MODE corrections
the Broadcast Period must be changed to 0.2 seconds.

The time required to acquire a fix is inversely proportional
to the rate of the corrections. By reducing the time for the
RTK engines to fix, RTK Verification and Validation can be
completed much quicker and surveyors can collect points
in locations that previously proved to be very difficult and
time consuming.

It is important to note that increasing the Broadcast Period,
increases the battery consumption of the radio as well as
the heat generation inside it. With the HPT435BT you may
need to use the modem fan when broadcasting with an
output power greater than 4 watts, depending upon the
ambient temperature.

The Base ID field limits the Rover from receiving corrections
if the Base and Rover profiles do not have the same Base ID.
It can be left at its default value of 0.

Transmit L2C is always enabled. If for some reason it is not
checked, it will become enabled automatically when the
Base is started with Base/Rover Setup.

To configure the UHF or FH915 parameters tap the UHF or
FH915 Configuration button.

Base/Rover Setup

" Esc

Base ID 0

UHF Configuration

Format RTCM 3.0 Min
Transmit L2C
Broadcast Period 1 Sec
DPOS Configuration >

UHF Base Configuration Screen

" Esc

Base ID 0
FH915 Configuration >
Format RTCM 3.0 Min
Transmit L2C
Broadca Period 0

DPOS Configuration >

FH915 SS Base Configuration Screen

OK

OK
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Tapping the UHF or FH915 Configuration button will trigger
animmediate search for the radio via Bluetooth between the
Base and the radio. If a Bluetooth enabled radio is not found
to be currently paired to the Base, you will be prompted to
pair the radio. This can be done via the Bluetooth option.

For UHF radios the parameters shown to the right need
to be configured. The Frequency should be one of your
FCC licensed (US users) frequencies. A channel with
little interference should be chosen. From the Frequency
selection screen you can Scan the displayed channels to
check the interference levels.

A Modulation (the method the data is encoded in the
radio signal) must be selected that has a sufficient link rate
to transmit increased data rates with 5 Hz corrections. If
Channel Bandwidsth is limited to 12.5 kHz by a FCC license,
D16QAM modulation must be used. With 2 Hz corrections
(0.5 second broadcast period) D8PSK modulation can
also be used. Modulations with greater link rates have
decreased receiver sensitivity to demodulate the signal
and the downside to choosing modulations with higher
link rates is that they are more subject to interference and
data loss when the signal is weak. Field test have found
that D16QAM modulation decreases the working range
of the radio approximately 20% as compared to DQPSK
modulation.

Increasing the Output Power increases radio range but
also increases radio power consumption. With an antenna
height 4 m (13.1 ft) and D16QAM modulation, 5 Hz RTK can
36

Frequency HPT401BT/AW401BT @®
Modula C
-~
-
Identification of radio. Please walit...
Output
Call Sig
FEC e FW
" Esc oK *
Common Settings Base Modem
Frequency 451.80000 MHz || HPT401BT/AW401BT ®
Modulation D16QAM || HPT404BT/AW400BT O
Channel Bandwidth (KHz) 12.5 | HPT435BT/AW435BT @)
C J

1000(30)

Output Power

Call Sign WCWL888

[FEC ][Scrambling ]E Unpair J[ Update FW J

Triumph-LS internal radio ID: 28, firmware: 3.2.4.17
+
Apply

Triumph-2 external radio ID: 79, firmware: 3.2.4.17

= Link Rate 19200 bps

UHF Configuration Screen

Base/Rover Setup



be stable up to 4 km (2.5 miles) away when terrain obstacles
do not block the signal. A hill or ridge between the Base and
Rover will greatly limit the range. The FCC (US) allows up to
35 watts ERP (Effective Radiated Power) to be transmitted.
If you have a HPT435BT radio set to output 35 watts and are
using an antenna that isn’t a unity gain antenna, such as the
5 dBd gain whip antenna, you aren’t in conformance with
the FCC regulations and terms of your license. With the 5
dBd gain whip antenna, an Output Power of 10 watts or less
must be used to stay under 35 watts ERP.

Your FCC assigned call sign should be entered in the Call
Sign box.

The Unpair button is used to unpair the Bluetooth
connection between the base and Rover. This would only
be necessary if you wish to pair a different radio to your
Base.

Update FW checks and installs the latest radio firmware.
The versions released October of 2015 or later are needed
for 5 Hz corrections to work correctly.

FH915 SS Radio Settings

With a FH915 SS radio Packet Repeating must be disabled
when using correction rates greater than 1 Hz.

In the US it may be best to operate on Channel 7 to avoid
interference.

Field test confirm 4 km (2.5 miles) as the range at which
stable 5 Hz RTK can be achieved with a FH915 SSradio with a
4 m (13.1 ft) antenna height. With 2 m you may achieve up to
2 km (1.2 miles), but it is dependent upon the environment.

Base/Rover Setup

UHF Modem Link Rates (bps)

Modulation

Channel |hppsk  [DaPSK  |D8PSK  |D16QAM
Spacing

6.25 kHz 2,400 4,800 7,200 9,600

12.5 kHz 4,800 9,600 14,400 19,200

20 kHz 7,200 15,000 22,500 |30,000

25 kHz 9,600 19,200 28,800 |38,400
Common Settings Base Modem

USA @ [,HPTSMBTIAWSOOBT OW
Australia O ‘ TR-1M/TR-1 FH RADIO @® |
Channel 7

Packet Repeating

Output Power 1000(30)

[FEC ][Scramhling ]{ Pair

Triumph-LS internal radio ID: 41, firmware: 3.1.16.0
Triumph-1 internal radio ID: 41, firmware: 3.1.16.0

Link Rate 64000 bps +
OK

| e |

" Esc

FH915 SS Configuration Screen
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Return to main Base/Rover Setup screen by tapping OK 3
twice. Press To Base to send modified parameters to the
Base. After doing this all the parameter values should be
yellow.

Disconnect Start Base

3 Triumph-LS 9DT_00151
JAVAD TRIUMPH2 00104

— .:? No Connection! :Tf

UHF
i 0 N 216197.8446m too far
The Base !oroadcast coordlna.te shpuld now be set. Tap on NAD83(2011) N e e joofar
the coordinate pane on the right side of the screen. RTCM 3.0 Min H 217.2261m
0.2 Sec Project1 - NAD83(2011) / Ohio South |
451.80000 MHz NAVD 88 GRD: 50ppm
8;?8@“’" 125KHz JAVTRIUMPH_2A NONE
1000/30 m\W/dBm 20m+0.025m Vertical
Ifthe be'lse is being started ona known point select tha.t point From Base|| To Base Recall || Copy As Done
From List or Enter the coordinates manually; otherwise use
an autonomous position by tappmg From Auto. Proposed Base Position Autonomous Position
From List Enter
indi P f N 220642.0996m
The 2D Delta indicates thfe.horlzontal d|§tance bgtween the (Auto] E 543910.6079m
current autonomous position the base is reporting and the | 220642 1773m Ergjse%gazam
i E 543911.0881 y
proposed broadcast coordinate. B Sas9 .08t m NAD83(2011) / Ohio ..
Project1 - NAD83(2011) / Ohio South |
Enter the Antenna Height and Offset. In this case the Base  |NAVD 88 GRD: 50ppm 2D Delt2:0.49 m

is on a 2 m pole with the thread adapter that adds an [Bmadcasﬁng Ref. Frame NADS3(2011)
additional 0.025 m. Tap OK once done. i
n

tenna Height:

Vertical | Height 2.0m | Offset 0.025m
| Esc

The base station raw GNSS data is always recorded and then - ok *
transfered to J-Field when Stop Base is pressed at the end
of a survey session so that it can be sent to Javad’s Data
Processing Online Service, also known as DPOS. With the
DPOS tool found in the CoGo menu the raw data file can be
submitted to DPOS and all the survey points from that base

E
)B Disconnect Start Base

Triumph-LS 9DT_00151

— Y NoComnectiont 'y JAVAD TRIUMPH2 00104

. . . . . UHF ! q
station session can be adjusted to their real coor<.j|‘nates so 0 N 220642 1773m .
they are no longer based off an autonomous position. The EIT\QS%ZSM) E 543911.0881m 1.96 m
recording interval can be specified along with some DPOS oogee Erar NADE3(2011) 1 Orie Sext |
options with the Rec box. 451.80000 MHz NAVD 88 GRD: 50ppm

8:]68ﬁM' 125 KHz JAVTRIUMPH_2A NONE
Once the coordinates for the Base have been selected/ 1000/30 mW/dBm 20m+0.025m Vertical

entered along with Antenna Height and radio parameters
tap Start Base.
38

From Base|| To Base Recall Copy As Done

Base/Rover Setup



In this screen you can enter / change the name of the point
being used as the base; to do so, tap Stored Point Name
and enter the desired name. It is recommended the Project
Name being included in the point name so that the file can
easily be identified in the DPOS tool.

Confirm sending the coordinates to the Base with a tap on
Yes, Store Point and Send to Base.

The parameters will be sent to the Base and radio and the
Base should begin to broadcast, typically after about 80
seconds.

The (transmitting) icon will indicate when the Base
is transmitting and OK will be displayed to the right of it.

Similarly, the Y (receiving) icon will indicate when the
Rover is receiving data. If the icon bars are red (as shown
with one red bar), this indicates that the radio transmission
is over powering the receiving radio and that the Rover
is too close for set Output Power. If the broadcast is too
overpowering, corrections will be lost and the link quality
will drop.

Base/Rover Setup

[Auto]

N 220642.1773m

E 543911.0881m

H 287.3021m

Proiect1 - NAD83(2011) / Ohio South | NAVD 88 GRD: 50ppm

Do you want to Start Base?

Stored Point Name Project1_Base
[Code Hub J[Page Paget J

Description ]

Yes, Store Point and
Start Base

Starting Base...
30.00%

1m40s

Disconnect 101ep

Stop Base

Triumph-LS 9DT_00151
JAVAD TRIUMPHZ2 00104

Project1_Base Hub

N 220642.1773m

E 543911.0882m

H 287.3021m

Project1 - NAD83(2011) / Ohio South |
NAVD 88 GRD: 50ppm

JAVTRIUMPH_2A NONE
20m+0025m Vertical

Receiving Y

0

NAD83(2011)
RTCM 3.0 Min

0.2 Sec

451.80000 MHz
D16QAM, 12.5 KHz
On, On

1000/30 mW/dBm

From Base|| To Base Recall Copy As Done
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Once the Base is broadcasting you can check that the Rover
is correctly receiving corrections at the set transmission
rate. Open the Collect or Stake Action screen. The position
solution button should display the correct incoming
correction rate and the communication button should
display a 100% link quality.

To check that you have started the Base correctly with the
correct coordinate, you may wish to stake a point you have
previously located if you have one available.

After the Base has been started you can press Done to
disconnectthe bluetooth oralternatively the connection will
be disconnected when the distance between the Base and
Rover exceeds the range of the Bluetooth communication.

After finishing surveying return to the Base again and
open Base/Rover Setup to Connect again and stop the
base with Stop Base. This will display a prompt to stop
the data transmissions and download the Base GNSS data
into J-Field. Choose Stop & Download. After the download
completes the Base can be powered off, the radio can be
powered off while the data is downloading without causing
any problems.

40

FIX 0.056f2 1
6/2:2 5.0Hz [308]

15

P I DTT

BACK

5.0
02.5 |zl

Are you sure you want to Stop Base (TRIUMPH2
00104) and download recorded raw GNSS file
(100_123721)?

Base/Rover Setup www.javad.com



Troubleshooting Starting the Base

If for some reason problems are encountered when trying
to start the Base, clearing the Base NVRAM is usually the first
recommendation.

How to clear the NVRAM

1. Turn the receiver OFF with the ON/OFF button.

2. Press and hold the Record button.

3. Turn the receiver ON by pressing the ON/OFF button.

4. Wait until all the LEDs are flashing yellow (except the
battery LED).

5. Release the Record button.

If the radio is transmitting, its TX LED should be flashing
at the broadcast rate. If the radio is broadcasting but
corrections are not being received in J-Field, check the UHF
Status screen for an “err” listed in the UHF State. If an error
state is displayed, press Restore CFG to restore the factory
UHF configuration.

UHF

Region ALL Data RX RTCM 3.0
Output Power Sent -
Frequency 451.80000 MHz Station ID N/A
Protocol JAVAD Distance NfA, no base coord.
Modulation D16QAM LQ, Delay

Ch. Bandwidth 12.5 KHz Data link latency |7.0 sec
FEC, Scrambling |On, 255 Received, Lost |-, 0

Link Rate 19200 bps

Call Sign

Antenna Internal

RSSI No signal (-147 dBm)

BER -

UHF State err, freq

S et st S ———

Configuration P Restore CFG >

" Esc

UHF Status Screen - UHF State "err, freq", Use Restore CFG to

repair

Base/Rover Setup
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Collect

Pressing the Collect button
opens the Collect Prepare
screen; pressing Collect
hardware button twice

will open the Collect Action
Collect

screen.

In the Collect Prepare screen, the Project, Page, Coordinate
System, ShapeTag, Code, Code Attributes, Point Name, Point
Description, Antenna Height and collection settings can be
setup before beginning data collection for a point.

When collecting points, it is recommended to use the
Code and Code Attributes to store information about the
point being collected. The Description field can then be
reserved for entering additional information about the
point. When exporting point coordinates in Text/CSV
format, these three fields can be merged into one field so
that surveying software can import data with the traditional
“Name,N,E,H,Description” format but with the description
being the combination of J-Field’s Code, Code Attributes and
Point Descriptions fields.

The Review buttons opens the Review screen which is a map
of the project. Here linework can be drawn on the map with
the CAD functions and point data can be edited.

The View button opens a screen to configure what point
attributes are displayed on the map and allows some

graphical parameters to be customized.

To the right of the View button is the Action Setup button

which opens a screen to configure the collection settings
for points. The RTK Verification and Validation settings are
configured from Action Setup screen.

Project1 -
NAD83(2011)...

Coordinate System

Project1

1. Project

DefTag
3. ShapeTag

5/8, Smith, ?
4. Code Attributes

101

5. Point Name

1.7 m

6. Point Description 7. Antenna Height

@

»
/
view || o Boundary

EEE

Collect Prepare Screen
G Pressing the Action hardware button or Next
from the Collect Prepare screen opens the
Collect Action screen.

=
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Screen Anatomy - Collect Prepare Screen

The Project button displays the name
of the current Project. Tap it to open
an existing Project, to create a new
Project, or to edit the current Project’s
name or coordinate system.

The Page button displays the name of
the current Page. Tap it to open the
Pages screen and set the current Page,
turn on or off Pages or edit a Page
Name or coordinate system.

The Coordinate System button displays
the name of the coordinate system for
the current Page. Tap it to change this
coordinate system.

ShapeTags can be assigned to points
during data collection to enable the
automated drawing of lines between
points with like Shapelags. “DefTag”
is the default Shapelag and does not
create lines between points.

The Point Name button displays the
name that will be assigned to the
next surveyed point. After a point is
surveyed it will increment to the next
available name.

The Review buttons opens the Review
screen which is a map of the project.
Here linework can be drawn on the map
with the CAD functions and point data
can be edited.

Project1

1. Project

DefTag

3. ShapeTag

101

5. Point Name

The View button opens a
screen to configure what point

Use the Point Description field to store attributes are displayed on the
additional information about the point. map and allows some graphical

parameters to be customized.

2. Page

Page2

Project1 -
NAD83(2011)...

Coordinate System

4. Code Attributes

1.7 m

7. Antenna Height

. Point Description

P
7., Boundary [09:03]

Displays the current Action Group pro-
file name group and opens the Action
Setup screen. The rover icon displays
whether tilt corrections are enabled
or not (disabled above). The clock icon
indicates the How to Stop? setting has
been set to a fixed number of epochs.

Collect

N

The Code button displays the name of
the Code that will be assigned to the
next surveyed point. Tap it to choose
a new Code from your list of Favorite
(odes.

Up to five variable Code Attributes
fields can be used be used to store
additional information about a point
with this box.

Edit the height of the ARP (Antenna
Reference Point).

Takes you to the Action screen

Displays the estimated remaining
battery life and is a shortcut to
the Battery Status screen
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Action Profile Setup

The Action Setup screen can be opened by tapping the
bottom middle button on the Collect and Stake Prepare
screens. It contains all the settings related to the collection
of points.

Action Setup (Boundary)

{Start with Start Button » J
{Only RTK Fixed —+—J {Verlfy with V6 resetJ
{Correct for Tilts [:]J{ A What To Record >J
{ Level Offset j{ggf\gﬂt Code to ShapeTag j
{ﬁ;ttii‘\)lzt:fr;st-Processing 5 min J{ Recall J

0

]
m

SC

P
o

Action Setup Screen - Recommended Settings for Multipath
Environments

There several different options to specify when data
collection for points starts and ends, the most commonly
used options being with the Start Button and after a
specified number of epochs have been collected. Using
a Start Delay may be useful if you need to collect a point
where you cannot reach the TRIUMPH-LS. You can press
Start and then set the TRIUMPH-LS up over the desired
point. The starting of data collection will be delayed by the
selected Delay period.

How to Start?

[ ¥ Start Button @j

[T_ When Lifted OJ

‘ # Proximity Sensor O ‘

‘ Sensitivity Level 5 ‘

Start Delay None
"~ Esc oK *
How to Start Screen

How to Stop?

¥ Stop Button

{ 7' When Tilted

®© After

Minimal Duration 120 sec
{Auto Accept NOJ
[Auto Re-Start NONEJ
"~ Esc oK *

How to Stop Screen - Recommended Settings for Surveying
Monuments in Multipath Environments with 5 Hz BEAST
MODE Corrections

What To Record presents options to automatically capture
raw GNSS data, camera images, voice recordings and
screenshots. To process rover data with DPOS, GNSS data
needs to be saved at 1 Hz.

Use Recall to quickly recall a saved Action Group profile. This

Collect



is useful for changing the collection settings for different
environments and types of points that need to be collected.

If Activate Post-Processing is enabled, raw GNSS data will
always to be logged in the background when points are
collected. If an RTK solution has not been accepted or
rejected after the set period of time, a Save for PP option
will be presented during point collection to save the GNSS
data with the point for post-processing. Rover GNSS data
can also be submitted to DPOS if it is recorded with the
settings in What To Record.

FIX 0.1641t-3 -4
2/3 5.04z [16]

Epochs(100), Time(120) H IV RMS, .01t
0,0 -
Conf.(10) + Consist.(-) V.Drift,mm

Reject

Save for PP button displayed after a fixed solution was not
able to be collected.

Collect



RTK Verification and Validation

It is very important that you read and understand the
information about RTK Verification and Validation
contained in this manual.

Verify Settings
Verify with V6 Reset @ {Verify w/o V6 Reset OJ
{Confidence Guard  0.131/0.23 ft J{Confidence Level 5 J
{Min RTK Engines at least 2 J{conSiStenCy Level 10 J
{Alarm on Resets DJ Max Groups 10 J

[Validate Result with at least 2 engines J

"~ Esc oK *

Verify Settings Screen - Recommended Settings for Multipath
Environments

When located in difficult environments and under tree
canopy, all GNSS receivers are prone to give bad fixed
solutions that may appear to be acceptable if they are not
verified. Existing methods to verify GNSS solutions include
“dumping”the receiver, turning it upside down to cause the
RTK engines to reset, and re-observing the point at a later
time.

J-Field automates these processes with its built-in software
features of Verify and Validate. Verify automatically resets
the RTK engines after every fixed epoch is collected in
Phase-1 of its process. Epochs are placed into Groups or
buckets during Phase-1. Once a Group has the required
Confidence Level Phase-1 is complete.

46

The Confidence Guard (CG) determines the size of the Group
or bucket. Each Group contains all the epochs located
within a specified radius (the CG value) from its center and
new Groups are created as necessary so that all epochs
fall into at least one Group. Each Group has its own Epoch
Counter, Confidence Level and Elapsed Time. A point may fall
into more than one group. The current best group is shown
within [ ] and others within ().

The number of groups is limited by the Max Groups setting.
If this number of groups is exceeded, Phase-1 will reset and
start over. During Phase-1, the current best group will be
displayed between the square brackets [ ] while the other
groups are displayed between parenthesis ().

During Phase-2 the engines are not reset and solutions
which are located inside the CG of the selected Group are
added to that Group for the remaining number of epochs
that user has requested (Epoch Number, EN) in the How
to Stop screen. Solutions which are outside the CG of the
selected Group will be ignored; the RTK engines are reset if
the epoch falls outside a sphere with a radius twice that of
the CG. If the number of rejected epochs reaches 30% of
epochs collected so far, the whole process will restart.

Validation is the final phase of the process. With this
feature enabled the RTK engines will reset one final time
at the end of the observation and collect 10 additional
epochs. Allowing sufficient time between Phase-1 and
the final Validation step will guarantee a bad solution is
not allowed to be accepted. From extensive testing in the
worst of multipath environments, a bad solution has yet
to be accepted when Verify and Validate are enabled with
a Minimum Duration of least 180 seconds. This will ensure
that at least two separate fixed initiations are acquired at
least 2 minutes apart. Having at least 2 fixed initiations in
agreement and acquired at least 2 to 3 minutes apart has

Collect



been found to be the critical requirement to ensure that
bad fixed initiations are not accepted. In high multipath
environments the Boundary Action Profile should be used
to meet this requirement and guarantee a good initiation.
You must let entire collection process complete. If the
process acquires fixes during Phase-2 and the RTK engines
then mediately reset many times, they are not in agreement
with the Phase-1 solution. The entire process will eventually
reset or you can manually Stop it, Reject the point and then
Start again. Alternatively, you may wish to not use the
Boundary profile but rather re-observe the point at least
2 minutes later, reseting the RTK engines before collecting
the 2nd point.

Confidence Level and Consistency Level are counters; the
Confidence Level of a group increments each time an epoch
with a new RTK initiation (Fix) is collected. It increments by
values of 1, 1.25, 1.5, 1.75, 2.0, or 2.5 for 1 to 6 fixed engines,
respectively. The Consistency Level of a group increments
with every epoch collected by values of 0, 0.1, 0.25, 0.5, 1.0,
and 1.5 for 1 to 6 fixed engines. The set Consistency Level
must be met before Phase-2 is allowed to end.

If high accuracy is needed in areas of high multipath and
areas with limited views of open sky (under full tree canopy
and urban canyon environments), longer observations
will improve accuracy. Repeated observation can also
be performed later (1 hour or more is recommended) to
improve accuracy. These repeated points can then be
averaged together with the Average function found in Cogo
Tools or with the Cluster Averaging function.

Recommended Collection Settings &
Default Action Profiles

Boundary Action Profile - To be used for control and

Collect

boundary shots and in high multipath environments (under
tree canopy, next to buildings, etc.)

Start with Start Button

Stop After: 100 epochs

Minimum Duration: 120 seconds (increasing this
to 180 is preferred in bad locations for additional
protection from accepting points with bad fixed
initiations and for better post-processing results)
Verify with V6 Reset

Confidence Level: 10

Consistency Counter: 10

Min RTK Engines: At least 2

Validate Result: with at least 2 engines

Correct for Tilts: Off (Rover pole must be plumbed)

Precise Topo - To be used for topographic shots where some
multipath may be present. The receiver should still have at
least a 50% clear view of the open sky.

Start with Start Button

Stop After: 10 epochs

Minimum Duration: 10 seconds

Verify with V6 Reset

Confidence Level: 5

Consistency Counter: 10

Min RTK Engines: At least 2

Validate Result: with at least 2 engines

Correct for Tilts: Off

Quick Topo - To be used for rapid topographic shots in open
sky environments. If it is difficult to obtain 5 engine fixed,
the environment may not be well suited for this profile and
the Precise Topo profile should be used.

Start with Start Button or Start When Tilted

Stop After: 2 epochs

Verify without V6 Reset

Consistency Counter: 0
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Min RTK Engines: At least 5
Correct for Tilts: On*

Stakeout - To be used for staking out points (See Stake
section of this manual). Staking point in areas of high
multipath still requires confirming matching fixed initiations
acquired at least 2 minutes apart. The Boundary profile can
be used for this. After the location of the point being staked
has been verified, Verify with V6 Resets can be turned off to
quickly fine tune the location on the ground.

Start with Start Button

Stop After: 30 epochs

Minimum Duration: 30 seconds

Verify with V6 Reset

Confidence Level: 5

Consistency Counter: 10

Min RTK Engines: At least 2

Validate Result: with at least 2 engines

Correct for Tilts: Off

In all above cases
Accept Fixed Only, RMS: All, PDOP: All
Confidence Guard: 0.164 ft

WAAS Float - This profile can be used to quickly collect
points with float solutions. SBAS tracking must be enabled
to acquire WAAS (Wide Area Augmentation System,
available in North America) float solutions. SBAS tracking
can be enabled from the Advanced Setup menu (press the
Set Up hardware button twice > GNSS).

If you wish to review point statistics or if you wish to edit the
ShapeTag, Code, Description and/or Attributes fields after
data collection, Auto Accept must be set to Off. If these
fields do not need to be changed and you desire fast data
collection with the Quick Topo settings, set Auto Accept to
On.
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*If Correct for Tilts is on, the Level Offsets must be calibrated
frequently if accuracies greater than 0.10" are needed.

If the point you are attempting to locate is near the edge
of a building, tree trunk or other obstruction, it often best
to use one of the CoGo Offset functions. When the most
accurate measurements are needed, the CoGo Resection
function found in the Intersections menu is recommended.

Collect



Instantaneous RMS estimate of the
current position solution

The current RTK correction rate being received

“FIX" (Fixed), “FLT” (Float), "CDF" (WAAS Code
Differential Float) or “STN” (Standalone) solution types
are indicated. Tap this box to open the RTK V6+ screen..

Number of engines fixed/number of
engines required by user

Returns to the previous screen

Shortcut to Satellite Status screen;
SV total*

Maximizes map view to full screen

Shortcut to the Review screen

(ycle through AutoZoom and 1:1
Zoom modes

Zoom out

Screen Anatomy - Collect Action Screen

Shortcut to the Action Setup screen;
the pitch (forward/back), roll (left/
right), and the azimuth or bearing
the unit is facing are displayed. This
box turns orange if the device is
tilted more that 5 ° with Correct for
Tilts off, or more than 30 ° degrees
with Correct for Tilts enabled. When
orange it prevents accepting |of
epochs in all modes except trajectory.

82.8960ft 952.\7730Ft

The map displaying point and lines
contained in pages that are enabled.
To expand the User Defined Buttons
press the Action hardware button.

Unassigned User Defined
Button, tap to assign

*Total number of SVs obsered by RTK
Rover may be different from number

of SVs observed by RTK Base

Collect

Shortcut to the applicable RTK corrections com-
munications screen; Currently corrections are
being received through WiFi with a 100% link
quality and full signal strength (as displayed by
the full bars of the signal strength icon)

Begin collecting a point; the current
time is displayed on the 2nd line

Shortcut to Selection of the type of
feature being located; Point, Line
Curve, Trajectory or Shift; choose by
Survey or by Offset

Antenna Height

D-SNR loss, displays the level (in dB) of
the signal strength loss and interfer-
ence in the L1/ L2 GPS and GLONASS
bands. Values 0-3 are desirable, 3-6
are fair and above 6 are poor.

Center map on current location

Zoom in, the scale is displayed as the
distance across the bottom of the
screen (between the user defined
boxes).

Current location in current Page

Tap once to preform the action
associated with the User Defined
Button (AKA White Box); long click
(touch and hold) to remove or change
the User Defined Button
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Screen Anatomy - RTK V6

GNSS satellite
count used in

A user definable threshold showing
given engine

allowable delay in seconds when
Extrapolation Mode is used .
GPS  GLONASS

3D RMS for the current epoch
in given engine

RTK V6+ support float engine: 1.919ft (97)
Number of seconds since the
last reset for a given engine

Fixed
Distance from the solution 0.071ft 0.071ft 0.071ft d 3.89ft
of the 1st engine 37

| 22 |

0.000ft | 0.000ft | ©0.000ft | 1.739ft | 1.739ft | 2.536ft |

8 [ 8 | 1 | 1 [ o0 |

Number of fixed solutions
since all engines were reset

Reset
Engines
Use this value to evaluate and T
compare the performance of eset racking
each engine. Esc Css

Charts plotting each fixed
epoch for each engine

Manually reset engines to compel new fixed
solutions when automatic verification is
turned off (unchecked)

%0 Collect www.javad.com



Screen Anatomy - Collect Action Screen
Screenshot after Phase-1 of RTK Verification is Completed

Time: Duration is seconds between the
first and last epoch collected

Current . .
epoch count Current  Current  Current  Target va?lﬁetsh shf)r\:\?n(;fr\eliﬂzytzetgsl
best other confidence confidence RMS of all sets
group  groups level level
inf]  in()

Horizontal (left) and ver-
tical (right) plots of the

Epochs(800), Time Level (5) collected epochs.  Each
( 6, 3 I 5 _} 0 Group has its own color.
Groups: (epochs, time, confidence(0.131/0.23 ft)) —— These p|0t5 currently have

G
[6,2,51 (1,1,0) ] 2 Groups.

Verify Statistics ol o o s

# of Phase-1 Restarts, # of Groups
Activate Post-Processing - 26 epochs
of raw data have been saved, 300
are required for the post-processing

option

# of Epochs outside the Confidence Guard
during Phase-2

1146 29.82

723896.8058FF 1784495.441Yft 943.3318ft

Coordinates of
Scales of the plots current position

Horizontal Vertical

Example One: Phase-1 ON

This Point was collected in a high multipath environment, several feet
away from a 2 story building.

Collect
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Screen Anatomy - Map Screen
Screenshot after Phase-2 and Validation Phase of RTK Verification is Completed

Number of epochs used in final Time between first Consistency Level  HRMS and VRMS
position and last epoch in of the Point of the Point in
Confidence Level seconds units of 0.01 ft
of the Point
‘\F Vertical Drift in mm per
100% ML minute  (RMS of the
Epochs(600), Time __HRMS; VRMS, 001t 1 Vertical Drift)
(610,190 |[ / 2,6/ |
Conf.(5) + Consist.(10) V.Drift,mm
(94 25 +265.2/| 37(14) .
Verify Statistics

# of Phase-1 Restarts, # of Groups

# of Epochs outside the Confidence Guard
during Phase-2

0. 130 0402

723896.7923fF 1784495.4291ft 943.4068ft

Final averaged Peak to peak distance
position of all Horizontal Vertical
positions Current page’s linear units

Example One: Phase-2

This Point was collected in a high multipath environment, several feet
away from a 2 story building. The effect of multipath can be seen with the
large vertical spread displayed in the vertical plot.
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Screen Anatomy - Collect Action
Screen with Expanded User

Defined Buttons

The User Defined Buttons are expanded by pressing the
Action hardware button. The most commonly used and
recommend User Defined Button options are shown
below:

FIX

0.066 ft-8 1
1.0nz [94] 9K

Point Name
101

ShapeTag Code
DefTag IPF
Verify Statistics Aftributes
0,0/0 5/8, Smith, ?
Distance to Last Point Description
- -

Photo Record
X

101 - IPF -

Many of the selected options are inputs for the same
parameters in the Collect Prepare screen. As with every
screen, more details can be found by pressing the Help
hardware button.

Stake

Similar to the Collect Prepare
screen  in  appearance
and function, the Stake
Prepare screen allows you
to configure the settings for
staking points.

NAD83(2011) /
Ohio South | ...

Coordinate System

Project1 Page1

1. Project

Points

3. Mode

2. Page

Create Point
4. Build

) Select Point

From Map / All

Sequence

Stake Line 1.7 m

5. Antenna Height

»
|l Z]
view || o Boundary Next

Stake Prepare Screen

Review

Additionally, the Prepare to Stake screen allows you to
define various Modes to stake which include a Points Mode,
several Alignment Points Mode and Alignment Stake-Here
Mode.

Sequence defines the order of the points to be stake. The
From Map mode is suggested mode for new users. This
allows you to pan the map cursor over a point displayed in
the map and tap Next to select that point to be staked.
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Stake Points Mode

. . Skip Already Surveyed

[DeSIQn Points O ‘ Staked Points D][Points o o
Points Traverse

Nearest Optimized . -
{Point O Path Length @) ‘ Alphabetic ) BEEULEING
{Use All Points On Page ® ‘ Select Points to Stake > OJ
[Max. Points in Sequence 100 ‘ [j}

[ Reset Sequence ]

Stake Sequence Screen

The suggested User Defined Button options for new users

100% IRREL

are displayed in the follow two screenshots.

FIX 0.167 ft3

p
51 1.0uz [s71 OK

723876.5328ft 1784482.0177ft 954 .5062f‘t
Stake Action Screen

When near the target point being staked tap Start to begin
collecting data and to average the displayed offset values.
When staking a point in a multipath environment, this is
an essential step that must be used with RTK Verification to
ensure the RTK initiation is correct. Choose Accept to store

the staked coordinate or Reject to discard them or to adjust
the position and try again.

0.174 1t3
1.0Hz [87]

2
5/1 OK

100%

‘ Target
1
DTT
87.1699ft Stone
Back Accept As
56.5996ft 101
Left Verify Statistics
66.2953ft 0,0/0
Fill
74.9294ft

Stake Action Expanded Screen

The CTT (Course to Target) Arrow User Defined Button option
in the top left box displays the direction to the point
being staked while the distance to it is displayed in the
DTT (Distance to Target) whitebox below it. Further down
are the Ahead/Back and Right/Left boxes that display the
distances to the point relative to the TRIUMPH-LS. The Cut/
Fill option is in the lower right box.

On the right side, the Target Name option is used as another
method to select the point being staked. When it is added
as a whitebox you must choose whether to “Key-in target
point name” or “Select target point from list” Select the
option you prefer. Below it are Point Description, Accept As
and Verify Statistics whitebox options.

The Accept As whitebox is useful if you wish to store the
staked coordinate of a design point as new point rather
than having it stored in the design point’s record. After
collecting the staked design point press Accept As rather
than Accept if you desire to store it as a new point.
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Real-Time Position Shift

Real-Time Position Shift, allows real-time corrections to be
applied to receive base station corrections. A base station
can be started with an autonomous position and then
corrected by surveying a point with known coordinates.
The known point could be a point previously surveyed with
a base station setup in a different location. This feature is
useful for several scenarios:

You need to move or “leapfrog” your base station to extend the radio
range into a new area.

Your original base station point has been lost.

You wish to save time by starting the base station with it mounted to
the top of your vehicle. Setting the base station and radio up on the

top of vehicle by mounting it a roof rack or using a magnet mount saves
time by eliminating the need to setup tripods and can help protect the
base station from disturbances or theft in undesirable locations. For the
best performance, the base station should be mounted in a near level
position so that phase center variations and antenna offsets are correctly
applied. If you are parked on a sloped surface, a swivel mount can be
used to level the receiver on the top of your vehicle. Your vehicle should
be parked on solid ground where it will not move or sink.

The Real-time Position Shift function can be accessed from
the Advanced Setup menu (press the Set Up hardware
button twice > Real-time Position Shift). In this screen,
select a point you have collected RTK coordinates from
with an autonomous base station and then the known
coordinates of this point. Check the Apply Shift and the shift
will be applied to all the RTK surveyed points found in the
current project collected from this base station. This shift
will continue to be applied to all the points surveyed from
this base station.

Real-Time Position Shift

Position Shift

| | (Apply Shift j[ Undo Shift j
:7. *. A
.’ P o’“ RTK from Auto Base Gl ailadell113
‘9 @ 100 102
gl @ 723013.07711 723906.1989ft
P O% 1784473.0585 178448100421t
925.2335ft 953.2972ft
L |\
Steel AE: 7.9457 ft
AU 28.0637 t
Position Shift Screen

Real-time Position Shift can also be accessed from the Collect
Action screen by clicking the button below the Start button
and changing the collection mode to Shift. In this mode
select the Known Point and then press Start from the action
screen to collect a point so that the offset can be calculated.
After it has been calculated you will be prompted to apply
the shift.

What?
E Point OJ[/ Line OJ[/’ CurveOJ[,/ Traj.OJ[@ Shift@}

Enter the coordinates of the point that you know.

Known Point

AN: 6.8782 ft
100
723913.0771ft b
1784473.05851 | AE: -7.9457 ft
925.2335ft
AU: -28.0637 ft

Then RTK this point to calculate the base shift.
This shift will be applied to all assctiated shots when "Apply Shift" box is checked.

Apply Shift (7 Undo Shift

Position Shift Screen from the Collect Action Screen
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Hybrid RTK with DPOS

When a GNSS RTK base station
is started by assuming an
autonomous  position, it s
necessary and good practice
to later adjust and correct
the coordinates with a GNSS
solution referenced from known
coordinates.  J-Field, has the
ability to adjust the base station
coordinates and  associated
RTK points surveyed with DPOS
(Javad’s Data Online Processing
Service). Your raw GNSS base
station data is sent to the DPOS
server from J-Field to be processed with CORS (Continuously
Operating Reference Station) data. DPOS then sends the
adjusted coordinate back to J-Field and J-Field applies the
adjustment to the base and rover coordinates.

Now with the introduction of Hybrid RTK in J-Field 2.0, raw
data files from the rover can also be post-processed with
DPOS. Your local base station data can be used to post-
process base to rover vectors; serving as an additional check
for the RTK solutions and as method to obtain accurate
solutions in areas where RTK corrections are lost. Rover
points with raw GNSS files can also now be post-processed
with CORS data.

Recording Raw GNSS Data

Base station data is automatically recorded when a base
stationis started with Base/Rover Setup. After done surveying
connect to base in Base/Rover Setup and choose Stop Base.
You will be prompted with several options. Choose Stop &
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Hybrid RTK with DPOS

Download so that the base data is downloaded into J-Field
and can later be processed with DPOS.

Are you sure you want to Stop Base (TRIUMPH2
00104) and download recorded raw GNSS file
(100_123721)?

Base/Rover Setup - Prompt to stop the base and download
data

You will be prompted with several options. Choose Stop &
Download so that the base data is downloaded into J-Field

and can later be processed with DPOS.

Rover GNSS data is recorded with points when this option is
enabled in the What To Record settings.

www.javad.com



On/Off Settings Record in Share
RAW GNSS Data w 1Hz [ 2] SD Card ‘ J
[Front Camera D Once at Start il Internal Memory J
[Bottom Camera D Once at Start il Internal Memory J
[Voice D 3 Sec il Internal Memory J
[Screenshots Al A2 E SD Card No J

[Record RTN Base

6

" Esc

What To Record screen - Recording of GNSS Data enabled

Raw data for rover points can also be saved with the Activate
Post-Processing option found in the Action Setup screen.

Action Setup (Boundary)

Start with Start Button J Stop After 100 epochs @

+} Verify [2]

[ )
[ )
O b What ToRecord >]
= J
[ )

Only RTK Fixed with V6 reset

Correct for Tilts

Revert Code to ShapeTag P
default

Level Offset J

Activate Post-Processing

option after Recall

5 min

Action Setup screen - Activate Post-Processing option after 5
min
300

When this option is enabled, the 26 (APP) button
will be display how many epochs of raw data have been

recorded and how many are required in the Collect and
Stake Action screens. Once the required number of epochs

have been met the button changes to display
Then once Stop is tapped the PP Options button is dlsplayed

1.329 3
FLT "50u, [

Epochs(100), Time(120)
3, 69

Conf.(10) + Consist.(10)

H IV RMS, 01t
3,4 |

V.Drift,mm

2+0 | -

0.095

723875.9818ft 1784483.9394ft 954.7210ft
Collect Action screen displaying the PP Options button.

Tapping this button presents the options to save the raw
data for post-processing.

0), Time(120) _HIVRMS, .01ft

3. 69 3.4
Recording Time: 1270 sec

Page2 102 | Attach

[Save for Post-Processing. Attach Raw GNSS J
data.

0.095

723875.9818ft 1784483.93941t 954.7210ft

Collect Action screen displaying the prompt to save raw data.
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Processing Raw Data with DPOS

To post-process the data, open the DPOS tool found in the
CoGo menu and select the base file you wish to process. It
can also be open by tapping the DPOS button found in the
Points screen.

100_2 112450

143_130406.jps N/A Yes No
143_133035.jps N/A Yes No
143_133359.jps N/A STN No
144_133724.jps N/A Yes No
145_141029.jps N/A Yes No
146_141309.jps N/A Yes No
147_142206.jps N/A Yes No

X 1966471.8543ft
Y -15943600.2229ft
Z13365620.3804ft
ITRF2008

DPOS Coords

DPOS -The Filter is Applied to Show Current Project Base Files
Only

With J-Field connected to the Internet, tap the

button to submit the raw data files for the selected base
station session to DPOS. The blue information panel
displays the status of the selected DPOS session.

The D (configuration) button contains various options
for DPOS processing.

DPOS configuration

[Send to DPOS automatically

810)

[Process all Points with raw GNSS files

(<]

Base-Processing only

Base-Processing + Base Shift

@ OO0

Base-Processing + CORS-Processing + Base Shift

oK *

DPOS Configuration Screen

" Esc

Send To DPOS automatically will submit GNSS raw data
to DPOS automatically when an Internet connection is
available.

Process all Points with raw GNSS files will submit all rover
raw data files to DPOS for processing even if they have not
been marked for post-processing.

Three processing types exist to determine how to process
the data:
Base-Processing - base and rover raw GNSS data are
uploaded to DPOS and base-rover vectors are then
processed
Base Shift - base station data is processed with
CORS data; the base station coordinate and survey
points collected from the base station session will be
automatically adjusted
CORS-Processing - rover points with raw GNSS files
are processed with CORS data (including your base
dataif this option is enabled in the Advanced settings)
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Note that as of J-Field 2.01.523, design points are not
adjusted but this feature is planned for the future. All
CoGo functions except Average create resultant points with
design coordinates.

Reviewing DPOS Results

The Base Rover Statistics screen can opened by tapping the
blue information panel. An acceptable solution should
have a Fixed solution, a 3dRMS of less that 3 cm (0.10") and
make use of multiple stations; if this is not the case, the data
can be reprocessed again at a later time by pressing the
ReDPOS button.

39°56'46.82228"N 083°00'22.67552"W 612.2249 @2010.00
709313.5946 1826544.1652 723.3067
39°56'46.88473"N 083°00'22.70465"W 601.6008
@2010.00
709319.9271 1826541.9319 712.6825
‘ SHFT: 160°34' 6.71 10.62
FIX: Yes 4060/4060 ‘ 2016-01-08 21:57:13 (00:30:30)
0.005 0.006 0.008
1.015 COLB,MTVR,OHHO,OHLI
ch: 0.011
6: 89°20'35" 0,: 0.011 op: 0.005
HGT:2.025m JAVTRIUMPH_2A NONE
Park100 DefCode
LewisRd Page1 it

Base Rover Statistics Screen
Full DPOS results can be reviewed in the Processed-Point
-

Info screen by tapping ‘——— found in the Point screen.

The detailed use of Processed-Point Info screen is explained
on the following two pages.

Hybrid RTK with DPOS
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Screen Anatomy - Processed Point Info Screen
Example of a Screenshot for a Base Point

Point Name - The name of the current point being reviewed, this box can be
formated to also display the Code and Description with a long click (notice
the arrow in the bottom left corner)

The current (radio button is selecting this column) coordinate type for the base and
associated rover points is KNOWN (base station was started from a known coordinate). If
the base station was started from an autonomous position this would be labeled AUTO.

Indicates this is a Base point

Horizontal and Vertical RMS

Number of Epochs /
Duration (time between
first and last epoch in
seconds)

Number of GPS +
GLONASS satellites

The current coordinates; the
coordinates in the selected
column  will be used
throughout J-Field as the
current coordinates. These
are the coordinates that will
be displayed in map, points
list, exports, etc.

60

Use Previous and Next to cycle through the list of surveyed points

M-Local - The Multiple Local coordinate/residuals are displayed in
this column. M-Local coordinates shift the associated surveyed
points with the same base station session to known coordinates.

(This point does not currently have M-Local coordinates.)

The post-processed CORS solution
for the base station (currently not
selected as the current coordinate)

I
UOO, Hub
v
P

o EEED
\

CORS
Base | AUTO O Fixed @ | 0-Local

N, ft -0.773 710518.283

E, ft -3.060 1837098.015

U ft +8.901 788.818

RMS, ft |2.339, 4103 2.339, 4.103

Epochs /s

Sats

Stat

" Back— z ‘ DX ‘ i) ==y
Residuals from the current Number of stations used
coordinate in this CORS solution
Info - The info button opens a

Base Rover Statistics - View the Base

text report for the post-processed
solution shown in this column.

Rover Statics screen for the solution

shown in this column.

Note, Audio, Screenshots and
Photos- Tapping these button will
display the point's Note, Audio,
Screenshots or Photos.  These
buttons will only be active when
the point has these attachments.

Attach - Use this button to attach
new media to the point

Map - View this point on the map
Edit - Open the Edit Point screen

Delete - Delete this point

Add M-Local - Use this button to add the current displayed point
as a M-Local point. Once tapped, you be prompted to select or
enter a coordinate. The translation from the displayed point
(100 in this example) to the enter coordinate will be calculated.
Multiple pairs of points can be added in M-Local to calculate a
best fit translation; hence the term Multiple Local (0-Local has 0
pairs of points, 7-Local has 1 pair, 2-Local has 2, etc.). Select the
M-Local coordinate (radio button set to this column) for any point

Hybrid RTK with DPOS

to then apply this translation to the selected point and all other
associated points with the base station session.



Screen Anatomy - Processed Point Info Screen
Example of a Screenshots for a Rover Point

Base Type - This box is painted green
when the current coordinate has the base
reference from this type of coordinate.
KNOWN indicates that the base was
started from a known position. If the base
station was started from an autonomous
position this would be labeled AUTO. Tap
this button to view the ABS coordinates
(absolute coordinates, shown in the
bottom screenshot).

Base Type - This box is painted red when
the current coordinate down not have the
base reference from this type of coordinate.
ABS (absolute) coordinates indicate that
the base station coordinates are reference
from a CORS adjusted solution or from local
control points when the M-Local coordinate
is chosen. Tap this button to view the
AUTO/KNOWN referenced coordinates.

RTK Solution with BCP (Base CORS
Processed) Solution

Base-Rover Post-Processed with BCP (Base
CORS Processed) Solution

Base-Rover Post-Processed Solution with KNOWN Base

(current coordinate in this screenshot)

(144, IPF JE Previous ‘ Next ﬂ
\7

~ RTK PPK

BNON Fixed O Fixed @

N, 1t -0.001 710982.271

E, ft -0.028 1837128.016

U it +0.018 786.961

RMS, ft  |0.027, 0.036 0.023,0.023

Epochs /s | 11 /307 1006 /1023

Sats 6+7 9+8

Stat 1070

_

S : e X
¢ ’
144, IPF « Previous Next M| =
g J
\ RTKscr PPKscr CORS 3-Local @

CEEI Fiied. O | Fixed . O | Fixed O | Cucusmea O

N, ft #0.031 +0.032 +0.367 -0.054
E. ft -0.018 +0.010 +1.036 0.019

Ut 0014 -0.032 2285 +0.062 @]
RWIS, ft  |0.027,0.036 |0.023,0.023 |0.590,0.492 |0.023,0.023
Epochs /s | 11/307 1006 /1023 |32/1023 1006 /1023
Sats 6+7 9+8 9+8 9+8
Stat 1070 5 144
x| rle|z|e =

Hybrid RTK with DPOS

RTK Solution with KNOWN Base, tap this
box to set the current coordinate to this
coordinate. You will be prompted with
several options:

Yes, For All - This option select this
coordinate type for all points with
associated with this base station
session.

Yes, For All (Auto RTK/PPK) - This
option will use an algorithm to
automatically select the best RTK
or post-processed coordinate for all
points with associated with this base
station session.

(ORS Post-Processed Solution

M-Local Solution - 3 pairs of
coordinates used in this example

Tap this column to view the setup
properties of the calculated M-Local
for this point
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M-Local

M-Local coordinates shift the associated surveyed points
with the same base station session to known coordinates.
Some possible uses for M-Local include:
Adjusting an autonomous base station to local
control points
Adjusting an autonomous base station to a post-
processed derived position such as OPUS
Shifting base and rover coordinates to the averaged
coordinate of multiple DPOS base station sessions

Adjusting an autonomous base station to local control
points

Use the <™ bytton found in the Processed Point Info
screen (see previous two pages) to add the current displayed
point as a M-Local point. Once tapped, you be prompted
to select or enter a coordinate. The translation from the
displayed point (144 in this example) to the selected
coordinate will be calculated. Multiple pairs of points can
be added in M-Local to calculate a best fit translation; hence
the term Multiple Local (0-Local has 0 pairs of points, 1-Local
has 1 pair, 2-Local has 2, etc.).
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Get from North, East, Up saveto
bl 0.00001t Dosign
Clipboard
B oo | o
List -
0.00007t & Settings
Map
Clipboard ]
NAD83(2011) / Ohio South | NAVD
88
Set the knowrl point for OK +

Add M-Local Point Screen - Prompted to select the known
coordinate for point 144

Base | Bearng | Distance | North | East | Up
100_2 | N19°8°38"E | 0.057ft | 0.0547t | 0.019ft | -0.062ft
Known Points AN AE AU Surveyed Points
30 144K -0.025 |-0.005 |0.000 3o 144
ne 146K 0.023 -0.052 |0.060 ne 146
» 147K 0.003 |0.057 |0.051
[@ Unlink J[Horizontal J[Verﬁcal DJ

M-Local Screen - 3 pairs of points shown

-
Apply

The M-Local Screen displays the translation along the top
row of the screen. Pairs of points can be used Horizontally,
Vertically or only as check points. The residuals for each
pair of points are shown in the middle of the screen. Be
sure to press Apply to save the added points to M-Local
and apply the adjustment to the associated base and rover
coordinates.

M-Local



—
144, IPF « Previ Next LINES
[' j[ revious ‘ ex J
RTKacr PPKgcp CORS 3-Local

- Fixed O Fixed O Fixed O Calculated O @
N, ft +0.086 +0.086 +0.421 710982.325
E, ft +0.001 +0.029 +1.055 1837128.035
U, ft -0.075 -0.093 -2.346 788.920
RMS, ft 0.027,0.036 |0.023,0.023 |0.590,0.492 |0.023,0.023 :
Epochs /s | 11 /307 1006 /1023 |32/1023 1006 /1023
Sats 6+7 9+8 9+8 9+8
Stat 10/0 5 1+4

&
0 = (o = o NERE ™

Processed Point Info Screen - The M-Local coordinate is the
current coordinate, 3 pairs of points exist in this M-Local
setup

If the M-Local coordinate is not currently selected (radio
button set to its column), select it for any point from this
base station session to apply its translation to the selected
point and all other associated points with the base station
session.

144, IPF < Previous Next )

G —

ABS ) ] =g )

N, ft

E, ft P
U ft Do you want to select the new coordinate? ‘ ‘

RMS, ft p

Epochs /
Yes, for ALL

Sats
3 : :

Processed Point Info Screen - Prompt to apply the M-Local

z [l =
coordinates to all the associated base and rover coordinates

Adjusting an autonomous base station to a post-
processed derived position such as OPUS

View the base point in the Processed Point Info screen and

press the =¥ putton. Then choose Manual and
enter the OPUS coordinates. After pressing OK you will
be prompted to enter a point name for the newly entered
coordinates. Once satisfied with the results in the M-Local
screen hit Apply to save and apply the adjustment.

Alternatively, you could create a new design point with the
known coordinates of the base station prior to entering the
M-Local screen by tapping the (Add) button found in
the design side of Points list and entering the coordinates
for the new point.

Shifting base and rover coordinates to the averaged
coordinate of multiple DPOS base station sessions

First average the base station coordinates from multiple
base sessions using the CoGo Average function. Next view

each base station point and use the @ pytton to
setup the translations to the averaged coordinate for each
base station point.
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CoGo

Most CoGo (Coordinate Geometry) functions in J-Field are
rather self-explanatory after viewing their diagrams. CoGo
Direct, Inverse, Shift and Rotate are found in the Basic group
of CoGo functions that will be explained here.

Basic
| 4w | | 1.\ || rp-2 || P |
i P-? P, ‘@ A0
s _® 15 o o/
i Y a /o P \u B
N
| D P o NN
. o, Py “afe
op, op, Py 3N
L J L 1 J L J L J
Direct Inverse Traverse Triangle
[~ o | N |
ne o e LN
o o i, 5 2.2
S 1B T\A/
e o ) .,,0 AW
1 dE I‘D
L B J L op, J
Shift Move Rotate
Esc

CoGo Basic Functions

In all CoGo function diagrams, labels shown in black are
inputs and labels shown in red are the resultant calculations.
Input points are displayed in green and red points are
resultant points created from the function.
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Direct
Direct
*N P1
477444.282T1
! P;-? 1775414.9944ft
i o ® v 74875411
1
1 . o Ar
:>D/ B, Grid: N 45°0'0.0" E
o, s || D, Ground: 100.0 ft
[Page Survev] H, Abs ‘ 0.0 ft
NAD83(20N1 A \)/ JD Ostéio South | (P2 P
DSN -
1775485.6984ft | £ 0.0034ft
0.0000ft
= +
CoGo Direct

Direct calculates the coordinate of a new point (P,) given
the coordinate of a known point (P;), bearing (B) and
distance (D) from P;.

Notice the vertical line in the white box shown between
H,Abs and the input “0.0 ft":

LH, Abs

0.0 ﬂJ

Clicking on the left side of this white box with H, Abs will
toggle it to the other options of H, Slope and AH

Clicking on the right side of this box will allow for the entry
of the value. This functionally is similar in all CoGo menus
when you see a white box separated with a vertical line in
the middle.

The resultant point is shown in the orange box. Clicking on
this box will allow you to edit the Name, Description and

M-Local



Code of this point.

Once all the inputs have been entered you may tap the
diagram to preview the results in the map. If satisfied, tap
Create to create the resultant points.

477479.6480ft 1775450.2808ft
Preview Screen of Cogo Direct

Inverse
Inverse P1 P2 [j
| * N | 477444 28271 477417 1785t
1 P, 1775414 99441t 1775404 8173t
1 B-? 748.75411t 748.61211t | Wy
[ (] v v n
[
: D-? B, Grid S 20°34'48.69268" W
1
@7p, o) 28.9546 ft
Page Survey || H, Avg 748.683 ft
NADB83(2011) / Ohio South | ~
NAVD 88 AX 7.871 ft
Relative Accuracy: 0.1082 ft
= +
Esc OK

CoGo Inverse - Ground distance is displayed, tap the D
button to cycle through the other distance type

Inverse calculates the bearing (B) and distance (D) of a line
between two known points (P & P,).

The U (multi-select) button can be used as a quicker
method to select both P; & P, from the point’s list.

{Survey @ ‘ Design O ‘ All OJ
‘Ot [Bame 09“23!201417181% 103 )
Date (Local :18:
9103 ‘ et Mag Naill 104
_ ik G NAD83(2011) | Ohi :un;;\ﬂ
Ccs io Sou
Qros NAVD 88
D106 North 477417.1785ft
East 1775404 8173ft
Qo7 up 74861217t
108 Epoch 2014.7285
D 109 Coords SRV:yes DSN:no BS:yes
Solution Type Fixed
LO1o )\ Processina Tvne RTK

nooDoDE

Multi-Select Screen - Selecting Points 103 and 104

P; & P, can also be entered directly from the keyboard by
typing in the point names. To use this option, long click the
P; & P, boxes (notice the small arrows in the bottom left
corner of these boxes).

| 9]
Press “ to switch the coordinates of Py & P,. Clicking on
the right side of output boxes such as B, Grid copies the
value of the box into the selected clipboard box.

M-Local 65



Shift

Shift
i e D
P, 9® @
(] o AN: 113061 | A
dN 2 A [ —)
p 1".17:‘ AE: 6477 1t
L3
AH: 0.0 | pros
Action Move Existing Points
Steel
+ 0.0034 ft
CoGo Shift

CoGo Shift and Rotate are useful for shifting and rotating
design points to desired geodetic surveyed locations.

Upon opening the Shift, Move or Rotate functions you will
be prompted two options: to Create New Points or Move
Existing Points. The Create New Points would need to be
chosen if the desire is to shift surveyed points. Surveyed
coordinates are blocked as options to be shifted is the Move
Existing Points option is selected. The Create New Points
would typically only be desirable and applicable to use if
some object needs to be physically relocated in the field
and the new location needs to be calculated. To adjust
surveyed coordinates from an autonomous base, Real-Time
Position Shift, DPOS or M-Shift should be used.

The Multi-Select screen is used to select the points to be
shifted. To select individual points in this screen, use

v |
the |! (Check Hardware) button for easier selection of
individual points.
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Design
1
09/26/2014 02:03: 45
. 2 Date [Local) i ||
3 Descrlptlon Stone|||3
Page Look
2 cs steel| |4
5 North 4758998590 | 5
East 1778475.1139ft
6 Up o000t || &
7 Epoch 2014.7349| || 7
8 Coords SRV:no DSN:yes BS:no g
Images o
9 Audio o||l9
10 an G.NSS E 10

ob

Multi-Select Screen - Selecting points 1 through 20, notice
the filter used to filter the list to points 1 through 20, the
select all button then is used to select all points

The ®—® (Delta) button can be used to calculate the delta
between two points, from the first selected point to the
second selected point.

The PPOS (Defta DPOS) button is used to recall the DPOS
shift from a base station session. Use this feature to shift
design points. (Automatic shifting of design points created
from CoGo functions is planned to be implemented in a
future version of J-Field.)

Tap the Move button once ready to shift the selected points.
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Rotate

Rotate
| p |PB 12
47744432461t
m [ 1775414.94571
) 74875411t
Pl !
\\A,' ¢ Points
v\
.Ps of A 1:4947.831808" | A
" Y Py

Page Look [Action Move Existing Points}

Steel

= +
Esc Move

CoGo Rotate

CoGo Rotate is very similar to CoGo Shift. Here the e—e
(Delta) button calculates the angle between the first
selected points to the second selected point with the
selected PB coordinate as the vertex.

M-Local
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Appendix A: Creating a RTN Profile

Open the Setup General Group; current: UHF
e
enuand Greate (7 om0 iR 8 e

a new General
Group profile

Action Group; current:

[/ Edit

Recall /
Manage

) ][ + Create J[ Copy As J

Favorites Codes & ShapeTags; current: Boundary Survey

[/ Edit Recall / ][ + Create J[ Copy As ]

Manage

[ Assign U1-U4 ][ Show Pop up Hints ]

—
Enter a name for LCg ODOT RTN
the new profile

UHF2 I TCP John

"1 0% [*3 4 |%s |'e |7 |'s | o

a |*w [*e 'R |°T Py [‘u I'1 |lo |'p
“Al-s *'o |'F e |'H |y L |
‘4|z | x|c|°v|s|N Ins
! space | M o
Select RTK Rover Operating Mode
mode RTK Base (@) ‘
Stand-Alone O ‘
p
Advanced J
\
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Select the
base reference
frame, typically

Base Reference Frame

WGSB4(ITRF2008) [@))| NADs3(2011) @

NAD83(2011) in NAD83(CSRS) QO || NAD83(PA11) (@)
the US [NAD83(MA11) O][ETRSBS OJ

RTCM3 (@)

RTK Corrections

Choose Real Time
Network Service
as the correction

type

Real Time Network Service €

RTN APN

‘APN(RTCM 3.0,NTRIP Client,WiFi,OFF)

Tap New to create
anew RTN APN
(Access Point
Name)

(APN(RTCM 3.0,NTRIP Client,WiFi,OFF)

Enter a name for
the new APN

Appendix A: Creating a RTN Profile



Select NTRIP
Client as the APN
Protocol

Enter the Host
Name, TCP

Port, Username
and Password
provided by your
RTN administrator

Tap the D

(list) button to
view the list of
mountpoints

Find the desired
mountpoint

and tap OK. A
mountpoint with
RTCM 3 format
and both GPS

+ GLONASS is
desirable.

APN Protocol

NTRIP Client

NMEA GGA needs
to be enabled if
connecting to

RTN Mountpoint

Enter Mountpoint or select from Source Table

R ey I |
thatisa VRS NMEA GGA J[NMEA Timeout SSecJ
(Virtual Reference
Station). Tap Next
RTN Caster Select the format Receive Format
‘ Host Name 156.63.133.115 ‘ of the mountpoint RTCM 3.0 @
TCP Port 2101 and tap Next RTCM 2.x (@)
Username JPS O
Password CMR/CMR+ O
RTCM 2.x (DGPS) O

RTN Mountpoint

Enter Mountpoint or select from Source Table

N
Mountpoint

Tap Done to exit
the setup

LNMEA GGA

][NMEA Timeout

Done!

sas

Source Table

Stream  |ODOT_VRS_RTCMS3, No: 5 ...
Mountpoint |ODOT_VRS_RTCM3

Authent.  |Basic

Format  [RTCM 3.1

Detals  |1004(1),1005/1007(5),PBS(10)
Carrier  |L1&L2

System  |GPS+GLONASS

Country  |USA

Latitude  |0.00 deg. North

Longitude [0.00 deg. East
Generator |Trimble Pivot Platform

Solution  |Network
Compress. |none

Fee No user fee
Bitrate |0 bps
NMEA |1

Misc.
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